
PART 3
The Cut Page



Chapter 18

Introducing the 
Cut Page

The Cut page is a focused environment for fast editing. It’s useful in 
situations where you need to quickly cut a news segment, build an 
episode of web content, edit a straightforward program, experiment with 
multiple arrangements of a scene, or put together a first assembly edit. 

The Cut page is also a good introductory editing interface for people who 
are new to editing, as it presents a streamlined set of tools that are fast to 
learn and simple to use. Whatever your background, you’ll find the 
Cut page to be a valuable addition to your editing experience in 
DaVinci Resolve.
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Overview of the Cut Page
With the addition of the Cut page, DaVinci Resolve now has two editing environments, intended 
for two different audiences. While the Cut and Edit pages share many of the same panels such 
as the Media Pool, the Timeline, and the Viewer, the controls that are exposed on the Cut page 
have been designed for speed, so you can cut professional programs faster than you’ve ever 
been able to before.

Overview of the Cut Page User Interface
The default workspace of the Cut page consists of the Media Pool, a single Viewer, and the 
Timeline area. These three regions let you quickly import and organize clips, edit clips, and 
even export the result, all from within the Cut page.

The Cut page default workspace, with the Media Pool in icon view

Customizing the UI
A User Interface toolbar at the top of the Cut page lets you hide and show different panels as 
necessary. For example, you can hide the Media Pool if you wanted more room for the Viewer. 
You can also replace the Media Pool with other browsers in the Media Pool’s default area, 
showing the Transitions, Titles, or Effects Browser in order to add those effects to your program 
in the Timeline.

Separate buttons let you open the Media Pool, Transitions browser, Titles browser, and Effects browser

You can resize the Media Pool and Viewer by dragging the vertical seam that connects them to 
the left or right, in the process making one panel bigger and the neighboring panel smaller. 
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The Viewer resize handle

You can also resize the Timeline area by dragging the timeline handle (at the upper right corner 
of the Timeline) up or down, making more or less room for the Timeline while simultaneously 
resizing the Media Pool and Viewer areas.

The Timeline resize handle

Choose Settings Before You Start
When you first create a new project, you need to define its project settings, and you can 
optionally choose whether or not to use Resolve Color Management to help you control the 
color of your video.

Projects Settings Quick Menu

This pop-up menu, to the top-right of the Viewer, lets you quickly choose which resolution you 
want to work at. A Custom option lets you open up the Master Settings panel of the Project 
Settings in order to choose your own options. For more information about the Project Settings, 
see Chapter 4, “Project Settings.”

The Project Settings quick menu
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Color Science Quick Menu
This pop-up menu, to the right of the Project Settings pop-up, lets you choose whether or not 
you want to stay with the default manually-managed color science of DaVinci YRGB, or use a 
Color Management scheme such as DaVinci YRGB Color Managed or ACES. Color 
management is a big topic; for more information about this powerful feature, see Chapter 7, 
“Data Levels, Color Management, and ACES.”

The Color Science quick menu

The Media Pool
The Media Pool contains all video clips, audio clips, graphics, and other media that you import 
into your project. You can create bins with which to organize all of this media, to make it easier 
to find what you need quickly. These bins are opened via the bin pop-up at the upper left-
hand corner.

Each piece of media you import, whether it’s video, audio, or graphics, appears as an individual 
clip and can be selected, scrubbed for fast viewing, reorganized into bins, opened into the 
Viewer for playback, or edited into a timeline using the edit buttons or via drag and drop.

The Media Pool in Icon view

Three buttons at the upper right of the Media Pool let you see your clips in different ways, 
depending on what you need to accomplish.
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The Viewing Modes buttons

�� Icon view: Each clip is represented by a scrubbable thumbnail. Hover the playhead 
over each thumbnail and move it left and right to see the clip’s image play, and use the 
I and O keys to mark sections of a clip that you want to use. Clicking on the lower right 
corner of a thumbnail reveals the clip’s metadata.

�� Filmstrip view: Each clip is represented by a filmstrip of consecutive frames the length 
of the Media Pool. Hover the playhead over the clip and move it left and right to see the 
clip’s image play, and use the I and O keys to mark sections of a clip that you want to 
use. Clicking on the lower right corner of a thumbnail reveals the clip’s metadata.

�� List view: Each clip appears as an item in a multi-column list showing a variety of 
metadata about each clip. In List view, you can click the header of any column to sort 
the contents by that column’s information (clicking again toggles the sort order between 
Ascending and Descending). Scrolling right reveals additional columns of information.

A Sort Media By pop-up menu lets you choose which criteria defines the order in which clips in 
the Media Pool are arranged. Options include: Timecode, Camera, Duration, or Clip Name, and 
you can choose to sort in Ascending (bottom to top) or Descending (top to bottom) order.

The Sort Media By pop-up menu

Lastly, a search field lets you type a term you want to use to find one or more clips that match 
that criteria. When you type anything, the contents of the Media Pool shrink to show only clips 
that match your criteria.
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The Viewer
The Viewer lets you see clips from the Media Pool, or clips in the Timeline, and has numerous 
controls to control what you see and how things play. 

The single Viewer in the Cut page

The Viewer has three modes. Which mode is currently in use can be seen, and switched, by 
three buttons in the upper lefthand corner of the Viewer. 

The Viewer modes buttons

Different modes are entered automatically by various actions:

�� You can double-click any clip to open it into the Viewer in Source Clip mode  
(the left button)

�� You can view an entire bin full of clips in Source Tape mode (the middle button)

�� You can play your edited program in Timeline mode (the right button)

Playing Clips and Navigating the Timeline
Eight controls sit at the bottom of the Viewer. These let you play through and otherwise 
navigate clips and the Timeline in different ways. These controls are described from left to right.

The toolbar at the bottom of the Viewer

�� Fast Review button: Intended to help you watch through a large collection of media 
quickly, clicking this button begins accelerated playback through Tape mode or through 
the Timeline, where the speed of playback is relative to the length of each clip you’re 
playing through. Long clips play faster, whereas shorter clips play closer to real time. In 
this way, you can watch a lot of material really quickly.

�� Effects button: The Effects button reveals a variety of controls for transform, crop, 
audio, speed effects, camera stabilization and lens correction, dynamic zoom, and 
compositing, covered in more detail later in this chapter.
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�� Jog control: Clicking and dragging within the jog control lets you scrub very precisely 
through the content of the Viewer.

�� Transport controls: A set of Previous Edit (Up Arrow), Stop (Spacebar), Play (Spacebar), 
Next Edit (Down Arrow), and Loop Playback (Command-/) buttons constitute clickable 
controls for controlling playback of clips and the Timeline. Each button has a matching 
keyboard shortcut.

�� Playhead timecode: A number field shows you the timecode value at the playhead of a 
clip or of the Timeline to give you a numeric reference for where you are.

Clip Effects
Clicking the Effects button reveals an Effects toolbar that you can use to add and edit clip 
effects, right within the Viewer with no Inspector needed. The Effects button reveals a variety of 
controls for transform, crop, audio, speed effects, camera stabilization and lens correction, 
dynamic zoom, and compositing, covered in more detail later in this chapter.

The Effects bar shown opened

Bypass Color Grades and Fusion
The Bypass Color Grades and Fusion Effects button/pop-up lets you turn off all grades and 
effects that you may have applied in the Color page and/or Fusion page in order to improve 
playback performance on low power computers. Click the button to disable or reenable grading 
and effects, or right-click this button to access a menu that lets you choose which things you 
want this button to control.

The Bypass Grades and Fusion button, 
shown being right-clicked to view its options

Audio Meter
An audio meter to the right of the Viewer shows you a graphical representation of the audio 
levels playing in the current clip or in the Timeline as you play through the Viewer, via animated 
vertical bars that are tinted to indicate how loud the levels are:

�� Green indicates safe levels

�� Yellow indicates levels that are peaking at approximately safe levels

�� Red indicates levels that may be peaking at levels that are too high, risking clipping the 
signal and causing distortion
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These animated bars serve as a visual reference you can use to help you adjust the volume of 
different clips to create a pleasing balance, and to make sure you don’t exceed the maximum 
desired level and introduce clipping. A speaker button at the top of the meters lets you mute or 
unmute audio playback.

The Audio Meter showing 
an audio signal

The Timeline
The word “timeline” refers both to an edited sequence of clips, which constitutes a program that 
is stored in the Media Pool, and to the area of the Cut page interface where you can open this 
sequence of clips to see its contents, and for playback and editing. 

Timelines are created and stored in the Media Pool, along with all of your other clips. However, 
each timeline is assembled and edited in what is sometimes referred to as the Timeline Editor. 
Different pages of DaVinci Resolve show your timeline differently according to the special 
requirements of each page focusing variously on different methods of editing, grading, 
compositing, and audio. However, while the interface of the Timeline Editor changes from page 
to page, the actual contents of the Timeline are identical, because each page’s Timeline Editor 
is in fact showing the exact same Timeline that is currently open. This means that the advanced 
user can use every page of DaVinci to do different things to the same Timeline, with only the 
interface changing to make different functions possible in different pages.

For the Cut page user, the Timeline is divided into an Upper Timeline at the top, and a larger 
and more detailed Timeline Editor showing a zoomed in portion of the Timeline around the 
playhead at the bottom. Working together, these two views of your edited sequence make it 
possible to navigate your entire project and cut in great detail. 

The Timeline of the Cut page, comprising the Upper Timeline and the zoomed in Timeline
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Upper Timeline
The Upper Timeline always shows the entire program within the full width of your computer’s 
display. The Upper Timeline’s playhead is always free, which makes it easy to use your pointer 
to scroll around the entire program by dragging within the Timeline Ruler at top. This also 
serves as a visual reference for keeping track of where you are in your program while you’re 
editing within the zoomed-in Lower Timeline below.

Despite the Upper Timeline’s relatively small size, you can still edit in it, with most editing and 
trimming functions that are available in the Lower Timeline also available in the Upper Timeline. 
Most interestingly, it’s also possible to drag clips from one part of your program in the Lower 
Timeline, to another area of your program in the Upper Timeline, and vice versa.

A set of small numbers to the left of the Upper Timeline lets you click a number to choose the 
currently selected track; this selection is mirrored on the zoomed in timeline below. The 
currently selected track affects where incoming clips will be placed when editing, among 
other things.

Lower Timeline
The zoomed in Lower Timeline (often referred to simply as “the Timeline”) shows you a close-up 
view of the portion of the currently open timeline that immediately surrounds the playhead. The 
zoom level is fixed; you cannot change it. The zoomed-in lower timeline is intended for detailed 
editing, but clips can be dragged between the Timeline and Upper Timeline for fast reordering 
of clips across the entire duration of your program.

Locked or Free Playhead
A pair of buttons at the upper left-hand corner of the Timeline lets you choose whether you use 
a locked or free playhead.

Two buttons let you choose to use a 
locked or free playhead

�� When set to locked, the playhead is fixed in the center of the Timeline, and your edited 
clips scroll past it as you play (press the Spacebar), jog, or shuttle (use the JKL keys) in 
either direction. Locked mode works great when you use the DaVinci Resolve Editor 
Keyboard. You can also scroll the Timeline using your pointer by dragging the Timeline 
Ruler at the top to the left or right, which also drags all of your clips to the left or right.

�� When set to free, the playhead moves across the clips as you play (press the Spacebar), 
jog, or shuttle (use the JKL keys) in either direction; the clips stay still. Once the 
playhead gets to the right or left edge of the Timeline, the Timeline pages over to 
reveal the next part of your edit. You can also move the playhead by clicking in the 
Timeline Ruler to jump the playhead to that frame, or by positioning the pointer over the 
playhead’s top handle, or over the playhead itself, and dragging the playhead wherever 
you want it to go.
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Tracks
The Timeline is divided into multiple tracks, with each track capable of holding a sequence of 
clips in order to create a program. The main tracks, which are labeled numerically, combine a 
clip’s video and audio into a single item in the Timeline, for simplicity. Editing the In or Out point 
of a clip edits the video and audio together.

Track 1 shows combined Video+Audio tracks in the Cut page timeline

TIP: In the Edit page, Video+Audio clips are presented as separated Video and Audio 
items on different tracks. When you open the Fairlight page, audio is presented on 
tracks with lanes, where each audio channel can be seen. In this way, each page gives 
you different sets of controls over the contents of the Timeline that are appropriate for 
each page.

Track Header Controls
Separate Lock Track, Audio Mute, and Video Enable buttons in each track’s timeline header let 
you separately Lock and enable or disable the audio and/or video of every clip on that track.

Controls to enable/disable/mute 
Video and Audio on a track

The Importance of Track 1
Each track in the Timeline of the Cut page is designed to carry specific parts of your program. 
Track 1 is intended for the primary video+audio of your program, often called the “A-roll,” since 
these are the primary shots comprising the timing and pacing of the story you’re telling. Adding, 
deleting, inserting, trimming, or otherwise rearranging clips on Track 1 results in the rest of the 
edited timeline being automatically rippled to accommodate the change you’ve made, with clips 
to the right of the changed area moving left to fill the gap of a deleted or shortened clips, or 
moving right to make room for an inserted or lengthened clip.
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Tracks 2 and Above
Tracks 2 and above are intended for “B-roll,” which is additional footage you stack on top of 
other clips in Track 1 to illustrate what someone is saying in the audio of Track 1, or for 
superimpositions used for compositing effects that combine two images together in creative 
ways. Moving or resizing clips on Track 2 and above only moves or resizes that one clip; other 
clips in the Timeline are not rearranged and the Timeline is not rippled when you do this.

For instances where multiple video clips overlap one another on multiple tracks, the video clip 
on the highest track obscures those on lower tracks, meaning that only the top clips appear 
during playback. This is useful when you’re experimenting with rearranging multiple clips in a 
complex scene. For example, you could be editing a scene where an interview clip is on the 
bottom track, and various b-roll clips are edited on tracks above the interview so you can freely 
rearrange them in different ways, while it’s always easy to reveal the speaker on the bottom 
track by leaving a gap in the superimposed b-roll clips.

Editing a scene with multiple superimposed clips

However, if you superimpose video-only or video+audio clips for compositing, you can use the 
composite modes and the opacity slider found in the Composite section of the Viewer Tools 
controls to mix multiple images together in different ways for artistic effects.

(Left) Superimposing clips you want to composite,  
(Right) Creating compositing effects with multiple superimposed clips

You can add additional Video+Audio tracks, when necessary, by either dragging a clip to the 
undefined gray area of the Timeline above the other existing tracks to make a new track 
automatically, by clicking the New Track button at the upper lefthand corner of the Timeline, or 
by right-clicking in the timeline header area and choosing “Add Video Track” from the 
contextual menu.
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Audio-Only Tracks
You can also edit audio-only clips such as music, narration, or sound effects, onto separate 
audio-only tracks underneath, which are then labeled A1, A2, A3, etcetera. If you drag an audio 
clip to the undefined gray area of the Timeline below the other existing tracks, an audio-only 
track will automatically be created.

Audio-only tracks in the Cut page timeline

Track Sizing
The height of tracks is automatically managed, with the currently selected track (selected by 
clicking the track header) appearing full-sized, and all others appearing shorter to make room. 
In this way, the Cut page timeline attempts to limit the amount of time necessary to zoom and 
pan around the Timeline.

The height of multiple tracks in the Cut 
page timeline is managed automatically

Gaps
Because Track 1 is meant to hold the principal clips for your program, the Timeline automatically 
rearranges itself to close gaps that would otherwise result when you move or rearrange clips in 
Track 1, and superimposed clips in Tracks 2 and above move to keep in sync with the clips 
they’re superimposed over. However, you can move superimposed clips on Tracks 2 and above 
to place them wherever you want, and gaps will be left between multiple clips on the same 
superimposed track so they can be edited at specific places.

Timeline Controls
Other buttons at the upper lefthand corner of the Timeline let you enable/disable Snapping that 
helps you align clips you’re dragging in the Timeline to align with one another, and to create 
Markers that let you keep track of important frames of the Timeline.
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Undo and Redo in DaVinci Resolve
No matter where you are in DaVinci Resolve, Undo and Redo commands let you back out of 
steps you’ve taken or commands you’ve executed, and reapply them if you change your mind. 
DaVinci Resolve is capable of undoing the entire history of things you’ve done since creating or 
opening a particular project. When you close a project, its entire undo history is purged. The 
next time you begin work on a project, its undo history starts anew.

Because DaVinci Resolve integrates so much functionality in one application, there are three 
separate sets of undo “stacks” to help you manage your work.

�� The Media, Edit and Fairlight pages share the same multiple-undo stack, which lets you 
backtrack out of changes made in the Media Pool, the Timeline, the Metadata Editor, 
and the Viewers.

�� Each clip in the Fusion page has its own undo stack, so you can undo changes you 
make to the composition of each clip, independently.

�� Each clip in the Color page has its own undo stack, so you can undo changes you make 
to grades in each clip, independently.

In all cases, there is no practical limit to the number of steps that are undoable (although there 
may be a limit to what you can remember). To take advantage of this, there are three ways you 
can undo work to go to a previous state of your project, no matter what page you’re in.

To simply undo or redo changes you’ve made one at a time:

�� Choose Edit > Undo (Command-Z) to undo the previous change.

�� Choose Edit > Redo (Shift-Command-Z) to redo to the next change.

�� On the DaVinci control panel, press the UNDO and REDO buttons on the T-bar panel.

TIP:  If you have the DaVinci control panel, there is one other control that lets you 
control the undo stack more directly when using the trackballs, rings, and pots. 
Pressing RESTORE POINT manually adds a memory of the current state of the grade to 
the undo stack. Since discrete undo states are difficult to predict when you’re making 
ongoing adjustments with the trackball and ring controls, pressing RESTORE POINT 
lets you set predictable states of the grade that you can fall back on.

You can also undo several steps at a time using the History submenu and window. At the time 
of this writing, this only works for multiple undo steps in the Media, Cut, Edit, and 
Fairlight pages.

To undo and redo using the History submenu:
1	 Open the Edit > History submenu, which shows (up to) the last twenty things you’ve 

done.

2	 Choose an item on the list to undo back to that point. The most recent thing you’ve 
done appears at the top of this list, and the change you’ve just made appears with a 
check next to it. Steps that have been undone but that can still be redone remain in this 
menu, so you can see what’s possible. However, if you’ve undone several changes at 
once and then you make a new change, you cannot undo any more and those steps 
disappear from the menu.
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The History submenu, which lets you undo several steps at once

Once you’ve selected a step to undo to, the menu closes and the project updates to show you 
its current state.

To undo and redo using the History window:
1	 Choose Edit > History > Open History Window.

2	 When the History dialog appears, click an item on the list to undo back to that point. 
Unlike the menu, in this window the most recent thing you’ve done appears at the 
bottom of this list. Selecting a change here grays out changes that can still be redone, 
as the project updates to show you its current state.

The Undo history window that lets you 
browse the entire available undo stack of 
the current page

3	 When you’re done, close the History window.

Chapter – 18  Introducing the Cut Page 402



Chapter 19

Importing and 
Organizing Media 
in the Cut Page

Before you can start editing, you need to import the clips you want to use 
for your program into the Media Pool, which is the central repository of 
clips in your project. This can include video, audio, and graphics files in 
any format that’s supported by DaVinci Resolve.

Once imported, the Media Pool on the Cut page has many organizational 
tools you can use to make your project’s media faster for you to access 
and sort through as you find the clips you need to create your program.
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Importing Media
Two Import buttons at the top of the Media Pool let you use import dialogs to select media you 
want to bring into the Media Pool for use in your project. 

The Import Media and Import Folder buttons

To import individual clips:
1	 Do one of the following:

a.	 Click the Import Media button.

b.	 Press Command-I.

c.	 Right-click the Media Pool and choose Import Media.

2	 Use the Import dialog to select one or more clips to import, and click Open.

3	 If you’re prompted to change the frame rate of a currently empty project to match that 
of the incoming media, click Change.

Each piece of media you import, whether it’s video, audio, or graphics, appears as an individual 
clip in the Media Pool. You can also import an entire folder full of media as a bin in the 
Media Pool.

To import a folder full of media into a bin:
1	 Click the Import Media Folder button.

2	 Use the Import dialog to select a folder containing media you want to import, 
and click Open.

3	 If you’re prompted to change the frame rate of a currently empty project to match that 
of the incoming media, click Change.

Each folder you import appears as a bin in the Media Pool. Double-clicking a bin opens its 
contents into the Media Pool, enabling you to view each individual clip.

TIP: For additional media import features, you can use the Media page, with its Media 
Storage browser and more feature-rich version of the Media Pool.

Removing Media
If there are clips you no longer want in your project, you can simply select them and press the 
Delete or Backspace keys. A Dialog asks if you want to remove the selected clip or clips; 
clicking Remove will remove them from the Media Pool, while leaving them intact on your media 
storage device.

If you want to remove every clip in the currently open bin (even the Master bin), you can also 
right-click anywhere within the Media Pool and choose Remove All Clips in Bin from the 
contextual menu.
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Organizing Media into Bins
For short projects, having all your clips together in a single bin (the Master bin is the top level of 
the Media Pool) can be fast. However, for longer projects, organizing your media into subsets of 
clips within individual bins can make browsing each bin’s contents using the Source Tape mode 
of the Viewer more manageable.

TIP: You can move clips you know you don’t want, such as instances where the 
camera rolled on unusable scenery or moments, or completely unusable takes, into 
another bin so those clips don’t present themselves in Source Tape mode for bins 
containing clips you want to use.

Master Bin
At the top level of your project hierarchy is the Master bin. The Master bin contains all of the 
media content (clips, timelines, graphics, other bins, etc.) for your project. In the Cut page, the 
Master bin also shows all of your project’s timelines for easy access, regardless of where 
they’ve been created in your project.

Creating and Using Bins
You can create bins with which to organize your media by choosing File > New Bin (Shift-
Command-N), or by right-clicking in the Media Pool and choosing New Bin from the contextual 
menu. You can create bins inside of other bins, and in so doing hierarchically organize the clips 
you need in a variety of ways.

Bins seen in the Media Pool

Once you’ve created a bin, you can move one or more selected clips into it via drag and drop, 
just as you would on the desktop of your operating system’s file manager.

Opening Bins
Any visible bin in the Media Pool can be opened by double-clicking it, or by clicking the bin 
pop-up at the upper left-hand corner of the Media Pool and choosing a bin to open from the 
menu (they’re shown as a hierarchical list). When opened, a bin’s contents fill the Media Pool, 
and a path indicator at the top of the Media Pool lets you see how many levels deep you are in 
cases where you have bins inside of bins. You can click any level of this path to jump back up 
the hierarchy, or you can choose another bin from the bin pop-up.
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The hierarchical Bin pop-up menu

Create Bin with Selected Clips
You can also create a bin and put clips into it in one step. Select one or more clips in the Media 
Pool, right-click one of the selected clips, and choose Create Bin With Selected Clips from the 
contextual menu. A new bin appears called “Bin X” (where X is the next number that’s available) 
displaying the selected clips it now contains.

Renaming Bins
To rename a bin, click its name once, then slowly click a second time (clicking too fast is a 
“double-click” which opens the bin), and the name becomes highlighted, ready for editing. You 
can also right-click a bin and choose Rename Bin from the contextual menu, which also 
highlights the bin’s name, ready for editing. When you’re done typing a new name, press Return 
(or Enter).

Media Pool Views
Once you’ve imported some clips into the Media Pool, three controls at the upper right-hand 
side let you control how they look, depending on what you need to accomplish.

The View Mode buttons

�� Icon View: Each clip is represented by a scrubbable thumbnail. Hover the playhead 
over each thumbnail and move it left and right to see the clip’s image play, and use the I 
and O keys to mark sections of a clip that you want to use. Hover scrub can be enabled 
and disabled using the Media Pool option menu on the Edit page.
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The Icon View mode

�� Filmstrip View: Each clip is represented by a filmstrip of consecutive frames the length 
of the Media Pool. Hover the playhead over the clip and move it left and right to see the 
clip’s image play, and use the I and O keys to mark sections of a clip that you want to 
use.

The Filmstrip View mode

�� List View: Each clip appears as an item in a multi-column list showing a variety of 
metadata about each clip. In list view, you can click the header of any column to sort 
the contents by that column’s information (clicking again toggles the sort order between 
Ascending and Descending). Scrolling right reveals additional columns of information.

The List View mode
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Sorting and Searching
Once you’ve imported media into your project, searching and sorting controls help you find 
what you need.

Searching
A search field lets you type a term you want to use to find one or more clips that match that 
criteria. When you type anything, the contents of the Media Pool shrink to show only clips that 
match your criteria.

Sort Media By
The Sort Media By pop-up menu lets you choose which criteria defines the order in which clips 
in the Media Pool are arranged. Options include: Timecode, Camera, Duration, or Clip Name, 
and you can choose to sort in Ascending (bottom to top) or Descending (top to bottom) order.

The Sort Media By pop-up menu

TIP:  If you want to sort by a criteria that’s not in the pop-up menu, you can switch the 
Media Pool to List view, then sort by any column you might want (such as “Date 
Created”), and then switch back to Icon or Filmstrip view.

Finding Timeline Clips in the Media Pool
From time to time, you’ll find yourself wanting to find the source clip in the Media Pool that 
corresponds to a clip in the Timeline. For example, you might want to go back to a part of an 
interview clip you’ve already used to find another phrase on the same topic.

To find a timeline clip in the Media Pool:
Right-click a clip in the Timeline, and choose Find in Media Pool from the contextual 
menu. The corresponding clip is selected in the Media Pool, which scrolls to show that 
clip, if necessary.
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Clip Color
Clip colors are an organizational tool that make it easier to keep track of different kinds of clips 
visually. For example, you can assign colors based on good takes, based on characters or 
subjects in the program, based on type of media (b-roll versus a-roll for example), or using any 
one of a number of organizational strategies. Whatever helps you keep track of things you need 
to keep track of.

Changing clip colors:
You can assign colors to clips by right-clicking one or more selected clips in the Media 
Pool or Timeline, and choosing one of 16 available colors from the Clip Color submenu 
of the contextual menu.

Removing clip colors:
Clip colors can be removed by right-clicking one or more selected clips in the Media 
Pool or Timeline, and choosing Clear Color from the Clip Color submenu of the 
contextual menu. 

Clip colors appear as a colored dot on a clip thumbnail when in Thumbnail view, as a clip color 
in Filmstrip view, and as a patch in the Clip Color column when in Column view. 

Clip color in – Thumbnail

Clip color in – Filmstrip

Clip color in – Column views

Clips with assigned colors also appear tinted in the Timeline, similarly to the Filmstrip 
tint in the Media Pool.

A timeline with audio clips that have been tinted to identify what they are to the editor 
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Generate Optimized Media
If you’re editing processor-intensive source formats such as camera raw, H.264, or 8K media, 
and your computer isn’t fast enough to work with it easily in real time, you can create pre-
rendered, low-overhead duplicate media to use instead, that’s automatically managed 
alongside the original media. This is called “Optimized Media.” Optimized Media lets you work 
more quickly by allowing you to edit with a more processor-efficient media format and 
resolution, while providing the ability to easily switch your project back to the original source 
media whenever you want. So, you can use optimized media to edit, and switch back to the 
original source media when it’s time to finish and output. Switching is as easy as choosing 
Playback > Use Optimized Media if Available to toggle optimized media on and off.

DaVinci Resolve automatically manages the relationship between source clips and the 
optimized media you create, so all you need to do is choose which clips to make optimized 
media for. For example, if you’re editing a project that consists of half camera raw media, and 
half DNxHD media, you only need to optimize the camera raw media, so you can use the search 
field to find all the raw clips you’ve imported based on Resolution, Codec, File Name, or 
whatever other metadata is appropriate.

To create optimized media:
1	 Select one or more clips in the Media Pool that would benefit from being optimized.

2	 Right-click one of the selected clips, and choose Generate Optimized Media from the 
contextual menu.

By default, all optimized media is written to the same directory as the cache files are written, 
which defaults to the first scratch disk listed in the Preference dialog’s Media Storage panel. 
The location of cache and optimized files is also selectable via the “Cache files location” setting 
in the Master Settings panel of the Project Settings.

Once you’ve created optimized media, all you need to do to use it is to choose Playback > Use 
Optimized Media if Available to toggle optimized media on and off.

For more information on choosing which format to optimize to, creating and managing optimized 
media, and how optimized media interacts with raw media, see Chapter 6, “Improving 
Performance, Proxies, and the Render Cache.”

Relink Selected Clips
DaVinci Resolve attempts to automatically keep track of the relationship between clips in your 
project and their corresponding source media on disk. If, for whatever reason, source media 
that links to clips in your project becomes unavailable because it’s been moved, 
DaVinci Resolve has several different methods of relinking those clips in the Media Pool. This 
section summarizes the primary method of relinking, the “Relink selected clips” command.  
For more information on other methods of conforming projects and relinking media, see 
Chapter 47, “Conforming and Relinking Clips.”

The appropriately named “Relink selected clips” command is the most flexible method of 
relinking clips in your project with clips in a directory of your choice, using file name and 
timecode as the primary criteria for reconnecting the relationship between each clip and its 
corresponding media file on disk.
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To relink selected clips or clips in a selected bin:
1	 Do one of the following:

–– Select one or more clips in the Media Pool browser that you want to relink, then 
right-click one of the selected clips or the selected bin, and choose “Relink Selected 
Clips” from the contextual menu.

–– Select a bin in the Media Pool bin pop-up menu that contains clips you want to relink, 
then right-click the selected bin and choose “Relink Clips for Selected Bin” from the 
contextual menu.

2	 When the Relink File dialog opens, choose a volume and directory in which to look for 
the files you want to relink to, and click OK. DaVinci Resolve attempts to find every clip 
with a matching file name in the subdirectories of the directory you chose, using the 
original file paths of the clips being relinked to do this as quickly as possible. By first 
looking for the clips in the directories they were originally in, relinking can be quite fast.

3	 If there are any clips that couldn’t be found using the method in step 2, you’re 
prompted with the option to do a “deep search” by a second dialog. If you click Yes, 
then DaVinci Resolve will look for each clip inside every subdirectory of the directory 
you selected in step 2. This may take significantly longer, but it should be completely 
successful so long as the media that’s required is within the selected directory 
structure.

4	 If there are still other clips that couldn’t be found, you’re prompted to either choose 
another directory altogether to continue searching, or quit.
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Chapter 20

Fast Editing in 
the Cut Page

The editing methods in the Cut page have been streamlined for fast 
editing, and the interface of this page and the methods of assembling 
clips together using different types of edits are designed to be easy to 
learn and quick to use.
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Creating and Modifying Timelines
After you’ve imported and organized the media you need to use in a program, the next thing 
you must do is create a timeline. Timelines are the organizational entities that contain the edited 
sequences of clips that make up your program. You can have as many timelines as you like in 
your project, with each timeline being an independent arrangement of clips. Timelines are 
stored in the Media Pool and can be organized using bins, just like clips.

Creating New Timelines
A timeline is automatically created when you edit your first clip into the Timeline. You’ll see an 
icon for the new timeline in the Media Pool, where you can rename it.

You can also create a new timeline by either choosing File > New Timeline (Command-N), or 
right-clicking in the background of the Media Pool and choosing Create New Timeline. A dialog 
appears that lets you choose a start timecode (the default is 01:00:00:00), a name, how many 
video and audio tracks you want it to have, what kind of audio (the default is stereo), and 
whether or not you want to create an empty timeline, or a timeline that automatically includes all 
clips in the Media Pool with or without selected In/Out points (a quick and easy way of creating 
a stringout of all clips you’ve imported).

By default, all timelines share the same frame rate, resolution, and monitoring settings as the 
overall project. If you like, you can also click the Use Custom Settings button to choose 
individual frame rate, resolution, and monitoring settings for that timeline. 

Once you’ve created a new timeline, double-clicking it will open it into the Timeline Editor.

Opening Timelines
If you only have one timeline in your project, that timeline is always seen in the Timeline Editor. 
If you have multiple timelines, you can double-click any timeline in the Media Pool to open it 
into the Timeline Editor, ready for editing.

About Tracks in the Cut Page Timeline
Tracks in the Cut page timeline combine a clip’s audio and video into a single track for 
convenience, as this makes it easy to keep audio and video organized and in sync when 
superimposing many clips together. This means that tracks have both video and audio enable 
controls in the track header controls, so that you can selectively disable video and mute audio 
when necessary.

The Lock, Audio Enable, and Video Enable buttons to the 
left of the track number, in the header of a timeline track

Each track also has a lock control, which lets you prevent clips on that track from being altered 
in any way.
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Adding Tracks
If your timeline doesn’t have enough tracks, you can either click the New Track button in the 
track header or right-click anywhere in the track header and choose “Add Track” and a new 
track will be added on top of the previously existing tracks.

TIP: Dragging a new clip to the undefined gray area at the top of the Timeline also 
adds a new track.

Deleting Tracks
If you want to delete a specific track along with all clips on that track, you can right-click 
anywhere in that track’s header and choose “Delete Track.”

If your timeline has too many empty tracks, you can right-click anywhere in the track header and 
choose “Delete Empty Tracks” and all empty tracks will be removed.

Navigating Clips in the Viewer and 
Timeline
Before you can start editing, you need to find which parts of which clips you want to use, and 
define where in the currently open timeline you want to make an edit. The Single Viewer in the 
Cut page has three modes that let you choose what media you want to play through using the 
transport controls found at the bottom.

Viewer Modes
Three modes, selectable via buttons at the upper left of the Viewer, let you control what the 
Viewer shows.

The Viewer Modes buttons, (left to right) 
Source, Tape, and Timeline

�� Source Clip Mode: This mode shows the currently selected clip in the Media Pool. This 
is the mode the Viewer automatically switches to whenever you double-click a clip in 
the Media Pool. In Source Clip mode, a jog bar appears at the bottom of the Viewer the 
width of which represents the duration of the currently open clip. A playhead within the 
jog bar lets you scrub through the clip as a zoomed-in waveform shows whatever audio 
is playing within the clip. Handles to the left and right of the jog bar let you reposition 
In and Out points within the clip to choose a section you want to edit into the Timeline. 
These In and Out points can also be set using the I and O keys. Once set, you can drag 
In and Out points to change them.

The jog bar in Source Clip mode, with In and Out points positioned to either side of the playhead
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�� Source Tape Mode: In this mode, every single clip in the currently open bin, and any 
subfolders in that bin, of the Media Pool is shown in the Viewer as a “stringout” in the 
jog bar at the bottom of the Viewer. In the jog bar, each clip appears one after the other 
in a long strip, with the order determined by the Sort order. This makes it easy to scrub 
through a whole collection of clips while you’re figuring out what you want to use. As 
you play through, whichever clip the playhead intersects is selected in the Media Pool, 
so you know which clip you’re looking at.

The jog bar in Source Tape mode, with each clip separated by a thin line

�� Timeline Mode: This mode shows the current frame at the position of the playhead in 
the Timeline. Whenever you click, drag, or adjust a clip in the timeline area, the Viewer 
switches to Timeline mode. In this mode there is no jog bar, you must use the timeline 
area to scrub through your program. However, in the space where the jog bar would 
otherwise be, icons appear to indicate when the playhead is positioned at the first or 
last frame of a clip in the Timeline.

The jog bar in Timeline mode shows icons to indicate the beginning and end of clips

Playing Clips and Navigating the Timeline in the Viewer
Eight controls sit at the bottom of the Viewer. These let you play through and otherwise 
navigate clips and the Timeline in different ways. These controls are described from left to right.

The toolbar at the bottom of the Viewer

�� Fast Review button: Intended to help you watch through a large collection of media 
quickly, clicking this button begins accelerated playback through Tape mode or through 
the Timeline, where the speed of playback is relative to the length of each clip you’re 
playing through. Long clips play faster, whereas shorter clips play closer to real time. In 
this way, you can watch a lot of material really quickly.

�� Effects button: The Effects button reveals a variety of controls for transform, crop, 
audio, speed effects, camera stabilization and lens correction, dynamic zoom, and 
compositing, covered in more detail later in this chapter.

�� Jog control: Clicking and dragging within the jog control lets you scrub very precisely 
through the content of the Viewer.

�� Transport controls: A set of buttons provide clickable controls to control playback of 
source clips and the Timeline, whichever the Viewer is set to display; each button has a 
matching keyboard shortcut. These include Previous Edit (Up Arrow), Stop (Spacebar), 
Play (Spacebar), Next Edit (Down Arrow), and Loop Playback (Command /).

�� Playhead timecode: A number field shows you the timecode value at the playhead of a 
clip or of the Timeline, to give you a numeric reference for where you are.
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Scrolling Through the Timeline
The playhead in the Cut page is fixed. When you play, shuttle, or jog through your program, the 
clips in the Timeline flow past the playhead from right to left if you’re playing forward, or from 
left to right if you’re playing backward. This means that for playback, editing, or trimming, you 
bring the frame you want to see to the playhead, rather than bringing the playhead to the frame 
(as you do on the Edit page).

To scroll or scrub through the Timeline, do one of the following:
�� Set the Viewer to show the Timeline, then use any transport or playback controls or 

keyboard shortcuts to move the clips in the Timeline back and forth, with the playhead 
indicating the current frame.

�� Position the pointer within the Timeline Ruler of the Upper Timeline, and drag to the left 
or right to scrub through your entire program.

�� Position the pointer within the Timeline Ruler of the larger Timeline Editor below, and 
drag to the left or right to scrub through the immediate vicinity of the current frame.

The Boring Detector
The Boring Detector performs a live analysis of the lengths of each of your clips on the Timeline 
and then highlights areas that are too long or too short and may demand your attention. It’s 
accessed by pressing the Boring Detector Icon on the far left of the Cut page Edit commands 
and can be toggled off by pressing the icon again.

The Boring Detector icon and the Timeline showing its results

Analyze Timeline Edits
The Boring Detector’s parameters are modifiable in its Analyze Timeline Edits window.

�� Boring Clips: By adjusting this slider, you can set the minimum number of seconds 
that a clip’s duration has to be before being flagged as too long. Clips that exceed this 
length are highlighted in light gray on the Upper Timeline.

�� Jump Cuts: Adjusting this slider sets the maximum number of frames that a clip’s 
duration has to be before being flagged as too short. Clips that are shorter than this 
length are highlighted in red on the Upper Timeline. Setting this to 2 frames can help 
you find accidental “flash frames” automatically.

�� Cancel: Closes the window without making any changes to the Boring Detector’s 
analysis.

�� Analyze: Starts the live analysis of your timeline using the criteria you’ve selected 
above. The Boring Detecter is persistent and continues to function as you make further 
edits in the Cut page. It can be turned off by clicking the Boring Detector icon again.
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The Boring Detector’s Analyze Timeline 
Edits window

Setting In and Out Points
Ordinarily, source media is much longer than the actual clips you’ll be using in a program, so it’s 
important to be able to define a range of media you want to edit into the Timeline. This is done 
by setting In and Out points, either in the Media Pool in Thumbnail or Filmstrip mode, or in the 
Viewer in Source Clip or Source Tape mode.

Setting In and Out Points Using the Keyboard
When scrubbing through a thumbnail or filmstrip in the Media Pool, you can press the I (In) or O 
(Out) keys to define a range of media. The edit points appear superimposed over the thumbnail 
area of the clip, as well as the jog bar of the Viewer if the clip is being mirrored there.

Defining a range of media in the Media Pool using 
In and Out points (in white)

When scrubbing or shuttling through media in the Viewer in Source Clip or Source Tape mode, 
or through your program with the Viewer in Timeline mode, you can press the I (In) or O (Out) 
keys to define a range of media. 

Defining a range of media in the Viewer using In and Out points
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When scrubbing or shuttling through the Timeline as you drag the ruler to the left and right, you 
can press the I (In) or O (Out) keys to define a range for incoming edit operations. The range is 
marked in both the upper and lower areas of the Timeline.

Defining a range of the Timeline for editing operations using In and Out points

Setting In and Out Points Using the Pointer
If you’re using a pointing device such as a mouse, trackpad or tablet, you can drag the In and 
Out handles found underneath the jog bar at the bottom of the Viewer to define a 
range of media.

The draggable In and Out controls at the bottom of the Viewer

Once you’ve set In and Out points, the jog In and Out controls, located at the far left and right of 
the jog bar in the Viewer, let you fine-tune the location of the In and Out points. Click and drag 
on the Jog In or Jog Out controls to move either edit point in precise increments. While you 
drag, a filmstrip above shows you how many frames you’re trimming.

The draggable Jog In control being used to trim the In point

In and Out points set in the Timeline Ruler (either of the Upper Timeline or the Timeline Editor) 
can be dragged to the left or right to fine-tune them.

The draggable In and Out points in the Timeline Ruler
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Smart Indicators
Some of the intelligent tools in the Cut page do not require you to select specific In and Out 
points in the Timeline. They rely on the playhead’s relative position over a clip to guess where 
you likely will want to make your edit. The point where DaVinci Resolve intends to make that 
edit is marked using a Smart Indicator icon on the Timeline Ruler.

Smart Indicator showing where an edit will occur.

Drag and Drop Editing
Drag and drop editing can be an easy way of assembling clips into a loose edit. Once you’ve 
defined a range of media using the Source Clip or Source Tape Viewer mode, you can click and 
drag either from the Viewer or the Media Pool to the Upper Timeline or the Timeline below to 
edit a clip into your program. How and where you drag determines how that clip will be edited.

Append
If you drag a clip onto an empty timeline, or to the dark gray area to the left of clips in the 
Timeline, that clip will become the first clip of your edit. If you drag a clip to the far left or right 
edge of all other clips in the the upper or lower areas of the Timeline, you will append that clip 
to the ending or beginning of the Timeline.

(Top) Dragging a clip to the far right of the Timeline 
to append it, (Bottom) The appended clip
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Ripple Overwrite
If you drag a clip onto a pre-existing clip in either the Timeline or Upper Timeline so that the 
entire clip highlights and you drop it immediately, you’ll perform a Ripple Overwrite edit, 
substituting the previous clip in the Timeline with the new clip. If you’ve ripple overwritten a clip 
on Track 1, all clips to the right of it will be rippled to make room if the incoming clip is longer, or 
close the gap if the incoming clip is shorter.

(Top) Dragging clip DD onto clip BB on the Timeline to Ripple 
Overwrite clip BB, (Bottom) Clip DD is shorter than clip BB, so the 
Timeline becomes shorter once the edit is done

Overwrite
If you drag a clip onto a pre-existing clip in either the Timeline or Upper Timeline and wait a 
moment, the Timeline overlay changes from a highlight over the whole clip to a highlight 
showing just the portion of the incoming clip overlaid on the existing clip. When you drop the 
clip, you’ll perform an Overwrite edit, which writes over the media that’s already in the Timeline 
with the media of the incoming clip. Overwrite edits don’t ripple the Timeline.

(Top) Dragging clip DD onto clip BB on the Timeline and pausing to 
perform an Overwrite, (Bottom) Clip DD overwrites the middle of clip BB, 
breaking it into two pieces while the Timeline remains the same duration

Using Cut Page Edit Commands
At the bottom of the Media Pool is a set of five buttons that let you make other kinds of edits. 
Some of these edits have keyboard shortcuts assigned to them and are also available via 
dedicated keys on the DaVinci Resolve Editor Keyboard.
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The edit buttons underneath the Media Pool, (Left to Right) Smart Insert,  
Append, Ripple Overwrite, Close Up, Place On Top, Source Overwrite

Setting Up and Performing Edits
No matter what kind of edit you intend to make, the process of setting them up and performing 
them is the same. This section describes the general process of setting up an edit, and the 
following sections will describe how each particular edit works.

To set up and perform an edit:

1	 First, locate a clip you want to edit into the Timeline. There are two general ways of 
doing this:

a.	� Open a bin with clips you want to use, then click Source Tape mode in the Viewer to 
show a stringout of all clips in the current bin, and its subfolders, in the currently 
selected sort order. Now, you can scrub around all these clips using JKL or the 
DaVinci Editor Keyboard’s shuttle/jog/scroll wheel to find the media you’re 
looking for.

b.	� Open a bin with clips you want to use, and navigate the thumbnails, filmstrips, or 
columns to select the clip you want, using the Search field if necessary to help find 
the clip you’re looking for. 

2	 Scrub a thumbnail or filmstrip, or use the controls in the Viewer, or use the controls 
of your DaVinci Editor Keyboard to locate frames at which you want to set In and Out 
points to define an edit range, and use the I (In) and O (Out) keys to set those points.

3	 If necessary, choose which video track you want to edit to by clicking in its track header 
to select it. Selected tracks are highlighted.

4	 Perform an edit to put the selected range of the source clip into the selected video 
track at the desired frame, using either the buttons at the bottom of the Media Pool, 
or keyboard shortcuts. Different edit commands will put the source clip into different 
locations.

5	 After you’ve committed your edit, you can press Q (or click the Timeline Viewer mode 
buttons) to switch the Viewer to the Timeline to play and review the edit you’ve just 
made, and then press Q again to switch back to the Source Clip or Source Tape mode 
(whichever was last used) to locate the next clip you want to edit, starting all over again 
at Step 1.

Smart Insert
Automatically inserts an incoming clip at the closest edit point to the playhead (as shown by the 
Smart Indicator) on the selected track, pushing all clips to the right of the edit point forward to 
make room for the incoming clip if you’ve inserted to Track 1. Because this is a smart operation, 
you are prevented from inserting a clip at any arbitrary frame; incoming clips are only inserted at 
the closest previously existing edit point.
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(Top) Before doing a Smart Insert,  
(Bottom) After inserting clip DD between clips AA and BB

Append
The position of the playhead is ignored; incoming clips are always placed after the last clip in 
the Timeline.

Performing an Append edit of clip DD to the Timeline

Ripple Overwrite
At its simplest, Ripple Overwrite substitutes a clip in the Timeline with an incoming clip. If you 
use Ripple Overwrite on a clip on Track 1, this will automatically move all clips that are to the 
right of the affected clip in the Timeline either forward to make room if the incoming clip is 
longer, or back to eliminate gaps if the incoming clip is shorter. 

Performing a Ripple Overwrite to substitute an entire clip at 
the playhead (BB) with the incoming clip (DD)

Chapter – 20  Fast Editing in the Cut Page 424



However, Ripple Overwrite works differently if you’ve set In and Out points in the Timeline to 
define a range. In this case, the incoming clip substitutes whatever portion of the Timeline falls 
within this range, moving all other clips that are to the right of the affected range either forward 
to make room if the incoming clip is longer, or back to eliminate gaps if the incoming clip 
is shorter.

Performing a Ripple Overwrite to substitute a In/Out range of 
the Timeline (part of clips BB and CC) with the incoming clip DD

Close Up
Lets you edit a clip into the Timeline as a zoomed-in close up, to make up for a lack of actual 
close ups that would have been shot with either longer lenses or by moving the camera closer 
to the subject. This function is particularly useful when you’re working with 4K media in a 
1080 timeline, or 8K media in a 4K timeline, which enables you zoom into existing wide shots to 
create medium shots, or medium shots to create close up shots, with no loss of quality. 

Performing this edit adds the incoming clip as an approximate 150% scaled close up, also 
performs a face detection, and if a face or faces are found automatically re-positions the face in 
the frame. Which frame of the Timeline the incoming clip aligns with depends on the following:

�� If no In or Out points are set on the Timeline, the incoming clip aligns with the Timeline 
playhead as the In point.

�� The incoming clip aligns with a timeline In point if one has been set.

�� The incoming clip’s Out point will align with a timeline Out point if one has been set 
without an In point. This “backtimes” the clip.

(Top) Before a Close Up edit,  
(Bottom) After editing clip DD into the Timeline with a Close Up edit
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Place On Top
Lets you edit the incoming clip as a superimposition above whatever other clips are in the 
Timeline; the incoming clip is always placed on top, so if there are clips in tracks 1, 2, and 3, the 
incoming clip is automatically placed on track 4, regardless of which track is selected. The 
frame the incoming clip aligns with depends on the following:

�� The incoming clip aligns with the closest timeline edit point in proximity to the playhead 
(as shown by the Smart Indicator) if no timeline In or Out points have been defined. The 
playhead is ignored.

�� The incoming clip aligns with a timeline In point if one has been set.

�� The incoming clip’s Out point will align with a timeline Out point if one has been set 
without an In point. This “backtimes” the clip.

(Top) Before placing a clip on top,  
(Bottom) After editing clip DD into the timeline with a Place On Top edit

Source Overwrite
This edit requires overlapping timecode in multiple clips to work properly, such as when 
recording synced timecode to multiple cameras during a multi-cam shoot. If there is no 
overlapping timecode, this edit does nothing.

If you are working with footage from multiple cameras that have synced timecode, then the 
easiest way to use this edit type is to set In and Out points over a clip in the Timeline where you 
want to cut away to another angle. In the following example, a wide shot of a cooking show 
covers the moment when the chef starts slicing a chili.

Setting Timeline In and Out points to identify a cutaway
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Alternatively, you can also use Source Overwrite to automatically place a source clip with a 
marked In/Out region on top of a clip in the Timeline so that its timecode syncs with the 
timecode of the timeline clip, when you don’t know exactly how much of the incoming source 
clip you want to edit into the Timeline, and you just want it synced appropriately.

Choosing a Media Pool clip from another camera 
that has overlapping timecode

When you click the Source Overwrite button, a synced section of the selected Media Pool clip 
will be edited into the Timeline between the In and Out points you placed, superimposed on 
top. The result is a perfectly timed cutaway.

Using Source Overwrite to edit a superimposed and synced section 
of the source clip into the Timeline between the In/Out points

Alternatively, you can also use Source Overwrite to automatically place a source clip with a 
marked In/Out region on top of a clip in the Timeline so that its timecode syncs with the 
timecode of the timeline clip, when you know exactly how much of the incoming source clip you 
want to edit into the Timeline, and you just want it synced appropriately.

Overwrite
While there’s no button available for performing an overwrite edit, you can use the F10 key to 
perform an overwrite edit, which overwrites a section of the Timeline with the incoming clip, 
without moving other clips in any way. The frame the incoming clip aligns with depends on 
the following:

�� The incoming clip aligns with the playhead if no timeline In or Out points 
have been defined.

�� The incoming clip aligns with a timeline In point if one has been set.

�� The incoming clip’s Out point will align with a timeline Out point if one has been set 
without an In point. This “backtimes” the clip.
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(Top) Before, positioning the playhead at the frame you want to 
use as the In point for the incoming clip, (Bottom) After overwriting 
the end of clip CC with incoming clip DD

Sync Bin
DaVinci Resolve has a number of tools to make editing multi-camera productions more intuitive 
and efficient. If simultaneously recorded clips from different cameras share common timecode, 
DaVinci Resolve can automatically sync all of these different camera angles together as you 
edit. The tools described in this section act as a sort of digital assistant editor that is constantly 
searching through all your media, and presenting all of the relevant shots to you at the exactly 
the right time. This functionality, combined with the DaVinci Resolve Editor Keyboard, makes the 
Cut page an extremely powerful multi-camera editor.

Preparing Footage for Sync Bin Editing
In order to properly work with the Sync Bin, every clip in that bin must have the following 
characteristics.

All Clips Must Have a Common Timecode Sync
Professional video cameras and audio recorders generally have the ability to “jam-sync” their 
timecodes together so that each separate video and audio source records the exact same 
timecode at the exact same time. Jam-syncing timecode is the quickest, easiest, and most 
reliable method to ensure your footage syncs perfectly.

If your footage does not have a common timecode, you will need to go through some extra 
steps to ensure that all your material matches up at the correct time. For more information, see 
the Sync Clips Window section below.

All Cameras Must Have a Unique Camera Name
Most professional video cameras will have some sort of mechanism for naming the camera in its 
internal menu system. This camera name is then recorded as metadata in each captured clip, 
which can be read automatically by DaVinci Resolve. Cameras should be named either 
alphabetically (A, B, C, etc.), or numerically (1, 2, 3, etc.), and in a sequential order totaling the 
number of cameras that you are recording with.

If your camera does not automatically record this information (or it’s set incorrectly), you can 
manually set the camera’s name by modifying the Camera # field in the Metadata Editor in the 
Media Pool.
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Sync Clips Window
If your footage does not share common timecode, or if the existing timecode needs to be 
modified for any reason, the Media Pool in the Cut page offers a Sync Clips window that allows 
you to modify the sync of all clips in a bin. It is accessed by clicking on the Sync Clips Window 
icon on top of the Media Pool.

The Media Pool Sync Clips Window Icon

The Sync Clips window opens and shows a live multi-camera sync Viewer on the left, and a 
standard clip Viewer on the right. There is also a timeline below that shows the temporal 
relationship of all the clips in the bin.

The Media Pool Sync Clips window

Sync By Tools
DaVinci Resolve offers several tools to automatically align your shots into perfect sync.

�� Timecode: This button will try to align all the clips in the Sync Clips window by 
timecode; this is the default option.

�� Audio: This button will try to align all the clips in the Sync Clips window by analyzing the 
audio tracks of each clip. In order for this to work, each clip must have at least a portion 
of the same audio track recorded clearly enough to analyze. An error message will 
notify you of which tracks could not be synced by this method.

�� In-Point: This button will try to align all the clips in the Sync Clips window by their user 
set In point. This is useful if you have a common mark that was shot across all cameras, 
for example a slate that claps closed, or a camera flash.

�� Out Point: This button will try to align all the clips in the Sync Clips window by their user 
set Out point. This is useful if there was a common tail slate.

�� Sync: This button will execute the Sync By method selected above.
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Once all of the clips in the window are synced appropriately, hit the Save Sync button in the 
lower right-hand side of the window.

The Media Pool Sync By icons (L-R: Timecode, Audio, In point, Out point)

Manually Syncing Clips in the Sync Clips Window
If none of the Sync By tools is appropriate for the clips in your bin, you can manually sync the 
clips together by dragging each clip to the appropriate position on the Sync Clips Window 
timeline. Each clip has its own track, and you can enable sync lock in the right-hand Viewer to 
prevent accidental slipping.

Once all of the clips in the window are synced appropriately, click the Save Sync button in the 
lower right-hand corner of the window.

Using Your Newly Synced Clips
After saving the sync on your clips, a new Multicam clip will appear in the Media Pool. If you 
select the Thumbnail View, a Sync icon appears on all the clips you modified. Once you place 
your first clip on the Timeline as a reference, you are now ready to use the Sync Bin to edit.

Sync icons (upper left arrows) identifying synced media clips

Sync Bin Editing
The core idea behind the Sync Bin layout is that instead of traditionally scrubbing through your 
timeline and clips independently, you now only have to scrub through your timeline. In the 
Media Pool, all of the clips that exist with that same timecode value will automatically scrub in 
sync with the playhead. This allows you to always have the exact clips that will fit perfectly in 
your timeline available at your fingertips.

Selecting this mode automatically changes the layout of the Media Pool and the Viewer to 
better accommodate multi camera editing in the Cut page.

Edit in Your First Clip from the Media Pool
Choose a clip that will be your base layer and place it on Track 1. This clip is used as the 
reference for all of the other clips in the Sync Bin. Then press the Sync Bin icon.

The Sync Bin icon
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Media Pool in the Sync Bin
All of the clips in the bin, and its subfolders, are presented in filmstrip mode. The clips are 
ganged together automatically by timecode and sorted by camera number. An additional 
playhead appears at the current timeline position, and moving any of the three playheads in the 
Cut page will scrub through all of the clips in the Sync Bin at the same time.

Viewer in the Sync Bin
The Viewer switches to a live Multi Viewer for up to nine cameras. Each camera is labeled, 
numbered, and the active camera in the Timeline is highlighted in red. Cameras that were not 
active at the current playhead time are blacked out.

The Media Pool and Viewer in Sync Bin view

Select Your Timeline In-Point 
Select the In point on your timeline by scrubbing the timeline playhead to the position you wish 
your media to start. As you do this, all of the clips in the Sync Bin will scrub along with the 
playhead position. Finding and selecting your edit points in the Sync Bin is greatly simplified, as 
all of your possible synced media choices are available instantly.

Select Your Camera
In the Multicam Viewer, select the camera angle you wish to use as your source material by 
doing one of the following:

�� Clicking on the appropriate camera in the Multicam Viewer

�� Clicking on the appropriate camera number icon in the Filmstrip Viewer

�� Pressing the number key of the camera on the keyboard

The Viewer will then go into Single Clip mode, showing the camera you selected. To return to 
the Multi Viewer, click on the circled X close icon, or simply press the Escape Key.

The clip will automatically set an In point at your current timeline position, with a default duration 
of five seconds. You can then manually set the Out point of the clip wherever you want.

The Multicam Viewer selection
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Make the Source Overwrite Edit
Once your clip’s edit points are chosen, click on the Source Overwrite button and your selected 
camera clip will be perfectly positioned in sync on your timeline. The playhead will then 
automatically advance to the clip’s Out point, the Multi Viewer will return, and so be instantly 
ready for the next edit.

Selected Camera 2 and Playhead In point on the Timeline, ready for Source Overwrite edit.

The completed Source Overwrite edit showing Camera 2 edited in, and the Timeline ready for the next edit

TIP: Because the actual media in the Sync Bin determines the overall limit of the clips, 
and not the timeline, it is possible to scroll past the end of the timeline to make an edit. 
When you are past the end of the timeline, the playhead now represents the Out-Point 
instead, which allows the clip to backfill itself to fit the exact duration required to fill in 
the timeline.
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Chapter 21

Trimming in the 
Cut Page

Once you’ve assembled a sequence of clips together into a loosely edited 
timeline, the Cut page provides numerous methods for modifying them in 
the Timeline. These tools are intended to improve the pace of your 
program by fine-tuning the timing of each clip, as well as the edits that 
separate them them. The idea is to make these kinds of adjustments easy, 
so your program’s content is clear, and the timing of your program’s 
playback is satisfying. This process of making modifications to the edits in 
a timeline is referred to as “trimming.” 
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Tools That Help You Work 
in the Timeline
As you begin the process of trimming clips in the Timeline, a series of buttons at the top left of 
the Timeline help you to align clips and keep track of important frames while you work.

Locked or Free Playhead

A pair of buttons at the upper left-hand corner of the Timeline lets you choose whether you use 
a locked or free playhead.

Two buttons let you choose to use a 
locked or free playhead

�� When set to locked, the playhead is fixed in the center of the Timeline, and your edited 
clips scroll past it as you play (press the Spacebar), jog, or shuttle (use the JKL keys) in 
either direction. Locked mode works great when you use the DaVinci Resolve Editor 
Keyboard, because the Timeline flows past the playhead while you use the Jog/
Shuttle/Scroll wheel. You can also scroll the Timeline using your pointer by dragging 
the Timeline Ruler at the top to the left or right, which also drags all of your clips to the 
left or right.

�� When set to free, the playhead moves across the clips as you play (press the Spacebar), 
jog, or shuttle (use the JKL keys) in either direction; the clips stay still. This mode can be 
useful when you’re doing precision trimming in the Timeline using a pointing device, as 
the clips stay put while you drag parts of clips to make adjustments. Once the playhead 
gets to the right or left edge of the Timeline, the Timeline pages over to reveal the 
next part of your edit. You can also move the playhead by clicking in the Timeline Ruler 
to jump the playhead to that frame, or by positioning the pointer over the playhead’s 
top handle, or over the playhead itself, and dragging the playhead wherever you want 
it to go.

Snapping
When dragging clips around the Timeline, you can click the Snapping button in the toolbar, 
or press N, to enable or disable snapping. 

The Snapping button in the Timeline track header
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When snapping is turned on, clip in and out points, markers, and the playhead all snap to line 
up with one another, making it easy edit clips together at their boundaries, or to line up clips 
with markers or the playhead as reference for key frames you want to cut to. When a clip’s 
boundary is snapping, a white line shows you the edges that are being aligned with 
one another.

The indicator that appears when clip 
boundaries are snapping to another edge

However, it’s also important to be able to turn snapping off when this behavior impedes your 
ability to make small adjustments to clips in the Timeline. You can press N to temporarily turn 
snapping on or off while you’re in the middle of dragging a clip in the Timeline, or while 
scrubbing the playhead using the pointer. 

�� When you change snapping while dragging a clip, an edge, or the Timeline, it’s 
considered to be a temporary operation, and snapping reverts to its previous state 
when you release the mouse button.

�� When you change snapping in between dragging operations, the snapping state 
remains set until the next time you change it.

Locking, Muting and Disabling Tracks
As you work in the Timeline, you may find it useful to lock tracks with clips you don’t want to 
accidentally change as you work. For example, you might lock an audio track that has an edited 
piece of music you’re now cutting other video and audio clips to, so you don’t accidentally alter 
or trim the music that serves as the base of your program. Clips on locked tracks appear 
stippled to let you know they can’t be altered.

A locked audio track, the Lock icon is closed and clips on that track are stippled

You may also find it useful to mute the audio or disable the video of tracks you don’t want to 
see while playing the Timeline. For example, you might want to disable a track filled with title 
graphics if you want to get a closer look at the underlying video in the background. Each track 
has Mute and Enable controls, while audio-only tracks only have Mute controls. White controls 
are enabled, while gray controls are disabled.
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Track 1 is disabled; the Enable button is orange and clips on the track are dimmed

Timeline Markers
You can place markers in the Timeline Ruler (of both the Upper Timeline and the Timeline 
Editor) to keep track of important frames of clips you want to remember, alternate edit points 
you’re thinking of, key moments in the edit, or to make notes of things you need to do. You can 
edit marker text, which appears as an overlay in the Viewer, and you can change the color of 
markers to distinguish them from one another.

The Marker button in the Timeline 
track header

Methods of working with markers:
�� To add a marker: Move the playhead to a frame you want to mark, then click the Marker 

button in the Timeline header, or press the M key.

�� To jump the playhead among markers: Hold the shift key and press the Up or Down 
Arrow keys to jump the playhead from marker to marker.

�� To edit a marker’s name, text, color, or keywords: Double-click a marker, or jump 
the playhead to a marker and press M again. When the marker dialog opens, edit the 
Name, Notes field, Keyword field, or color of the marker, then press Return or click 
Done to close the dialog. Markers with custom notes appear with a dot.

�� To move a marker: Drag a marker to another frame in the Timeline Ruler.

�� To delete a marker: Select a marker, and press Delete. Or, align the playhead with a 
marker, and press Option-M. Or, jump the playhead to a marker, press M to open the 
marker dialog, and then click Remove Marker.

Blue, red, and orange markers in the Timeline; the red marker contains text, the others do not
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Making Selections
As you continue to work in the Cut page, it becomes increasingly helpful to know how to make 
different kinds of selections, both in the Media Pool and in the Timeline. Most of these methods 
of selection should be familiar to you if you have experience with other media applications or 
file managers.

Methods of selecting clips in the Media Pool:
�� To select a single clip: Click a clip in the Media Pool. Once you’ve selected a clip, you 

can use the Up and Down arrow keys to move the selection to other clips.

�� To select a contiguous range of clips: Drag a selection box over all the clips you want 
to select, or click to select the first clip in a series, then Shift-click the last clip to select 
those clips and everything in between.

�� To select a noncontiguous range of clips: Command-click each clip you want to 
include in the selection. Or, you can hold the Command key down while you drag 
bounding boxes over unselected clips to add them to the current selection, or over 
selected clips to remove them from the selection.

�� To select all clips: Select one clip, then choose Edit > Select All (Command-A).

Methods of selecting clips in the Timeline:
�� To select one clip: Click a clip with the mouse. Command-clicking that clip de-selects it.

�� To de-select all clips in the Timeline: Click in any empty area of the Timeline to 
de-select everything, or press Command-Shift-A.

�� To select a continuous range of clips by dragging: Drag a bounding box from an 
empty area of the Timeline to surround a group of clips.

�� To select a continuous range of clips by Shift-clicking: Click the first clip you want to 
select, and then Shift-click the last clip you want to select, and all clips in-between will 
automatically be selected as well.

�� To select a discontinuous range of clips: Command-click any clips to select them 
no matter where they appear on the Timeline. Command-clicking a selected clip 
deselects it.

�� To select all clips in the Timeline from the playhead forward: Right-click the top 
handle of the playhead, and click the right button on the radial menu that appears.

�� To select all clips in the Timeline from the playhead backward: Right-click the top 
handle of the playhead, and click the left button on the radial menu that appears.

The radial menu that appears 
when you right-click the top 
handle of the playhead
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Methods of selecting edits in the Timeline using the pointer:
�� To select an edit to roll: Move the mouse to the center of an edit point, and when the 

ripple cursor appears, click to select the edit.

�� To select just the incoming or outgoing half of an edit point to resize: Move the 
mouse to the left or right of the center of an edit, and when the resize/ripple cursor 
appears, click to select that portion of the edit.

�� To select multiple roll points: Command-click the center of multiple edit points. 
Command-click a selected edit point to deselect it.

�� To select multiple resize points: Command-click the left or right sides of multiple 
edit points.

�� To de-select all clips in the Timeline: Click in any empty area of the timeline to de-
select everything.

Keyboard shortcuts for selecting edits in the Timeline:
�� To select an edit point from the keyboard: Press V to select the nearest edit point to 

the playhead.

�� To change an edit selection from the keyboard: Once you’ve selected an edit point, 
press U to toggle among selecting the outgoing half, incoming half, or the entire edit.

�� To de-select all edits in the timeline: Press Command-Shift-A.

Moving Clips in the Timeline
Once you’ve edited some clips into the Timeline, you’ll probably want to start fine-tuning the 
edit by moving clips around. Different operations can be performed depending on how you 
move these clips. All of these techniques work in both the Upper Timeline and the 
Timeline Editor.

Ripple Overwriting An Entire Clip in Track 1
Drag a clip in the Timeline or Upper Timeline over another clip in the Timeline so that the 
pointer overlaps that clip, and quickly drop it onto another clip in Track 1. The clip you dragged 
replaces the clip you dropped it onto, and all clips to the right are moved to either make room 
(if the dragged clip is longer) or to close the gap (if the dragged clip is shorter).

(Top) Clicking clip BB to begin dragging it, (Middle) Dragging clip BB onto clip DD 
to ripple overwrite it, (Bottom) Clip BB is moved and takes the place of clip DD, 
while the rest of the Timeline moves left to close the gaps in Track 1
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NOTE: If you wait too long, this Ripple Overwrite operation will turn into an overwrite 
operation. If you drag a clip in Track 1 onto a clip in any other track, you can only do an 
overwrite, not a ripple overwrite.

Overwriting the Middle of Other Clips
Drag a clip in the Timeline or Upper Timeline over another clip in the Timeline so that the 
pointer overlaps that clip, and pause until the clip you’ve selected is overlaid on top of the 
second clip, and release the mouse button. The target clip is overwritten by the duration of the 
clip you dragged and split in two.

(Top) Dragging clip BB and pausing to overwrite part of clip DD, (Bottom) Clip 
BB is moved, overwriting the middle of clip DD which is now in two pieces; the 
rest of the Timeline moves left to fill the gap left by moving clip BB in Track 1

Overwriting The Edges of Other Clips
Drag a clip in the Timeline or Upper Timeline over the edge of a neighboring clip without letting 
your pointer overlap it, then drop the clip. The overlapping part of the neighboring clip will be 
overwritten.

(Top) Dragging clip CC to partially overlap clip DD in order to overwrite it, 
(Bottom) After dropping clip CC to partially overwrite the beginning of clip DD, clip 
DD is shortened and the other clips in the Timeline move left to fill the gap in Track 1

Swapping Clips
Drag one or more clips from one part of the Timeline or Upper Timeline to another so that the 
pointer overlaps an edit between two clips (the edit point turns purple), and drop the clip. The 
clip(s) you dragged are now moved so that they’re inserted at the edit point you targeted.
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(Top) Dragging clip CC to swap it between clip II and JJ, (Bottom) Dropping clip CC rearranges 
the Timeline, which automatically closes all gaps and move clips to the right where necessary; 
superimposed clips are kept in sync with clips in Track 1 that have moved

Copy, Cut, and Paste
Clips can be cut, copied, and pasted in the timeline or Upper Timeline to duplicate them or 
move them around, just like words in a word processor. 

To cut/copy and paste in the Timeline:
1	 Select one or more clips in the Timeline.

2	 Do one of the following:

a.	 Press Command-C to copy them (the selected clips remain where they are).

b.	� Press Command-X to cut them (the selected clips are removed and the Timeline 
automatically ripples itself to close the gap).

c.	� Move to another part of the Timeline, then press Command-V to paste the clips. 
The clips are pasted to the frame at the playhead, to the same track they were 
copied from, and overwrite whatever other clips are at that part of the Timeline.

Splitting Clips
You can split any clip into two pieces, effectively adding an edit point in the middle, in 
preparation for moving part of a clip, deleting part of a clip, inserting another clip at that edit 
point, or adding an effect of some kind to one part of a clip but not another.

To split a clip:

1	 Move the playhead to the frame of a clip where you want to split it. 

2	 Do one of the following:

–– Right-click the clip and choose Split from the contextual menu.

–– Right-click the top handle of the playhead and click the Split button that 
appears on the radial menu.

–– Press Command-Backslash.

–– Press the Split Clips (scissor) icon on the far left of the Cut page Edit commands.
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(Left) Before splitting a clip, (Right) After, a new edit point bisects the clip into two pieces

Disabling and Deleting Clips
Clips that you no longer want can be disabled or deleted.

Disabling and Muting Clips
You can turn off the audio and/or video for a clip in the Timeline, without removing the clip itself. 
This is useful in instances where you want to use a clip’s audio or video selectively, or for 
instances where you want to disable the audio and video for a clip that you don’t want to use, 
without eliminating it completely from the Timeline in case you change your mind.

Disabling Clips
You can turn off a clip’s video while leaving it in the Timeline by selecting it and pressing D, or 
by right-clicking it and deselecting Enable from the contextual menu. The clip turns dull to show 
it’s disabled. Audio will continue to play for that clip unless you mute it as well.

A disabled clip in the Timeline

Muting Clips
You can turn off a clip’s audio while leaving it in the Timeline by right-clicking it and choosing 
Mute from the contextual menu. A mute icon is superimposed over the beginning of the clip to 
show audio is disabled. Video will continue to play for that clip unless you disable it as well.

A muted clip in the Timeline
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Deleting Clips
If you want to completely eliminate one or more clips from the Timeline, select them and press 
the Delete key. The clip(s) will be removed. If you’ve deleted a clip on Track 1, the Timeline will 
ripple to close the gap automatically.

(Top) Selecting clip DD to delete it, (Bottom) Deleting clip DD results in clips EE through NN moving left 
to fill the gap in Track 1; superimposed clips move to keep in sync with the clips underneath them

Deleting Parts of Clips
If you want to delete only part one or more clips, set In and Out points around the section of the 
Timeline you want to delete, and press the Delete key. The section of the Timeline between the 
In and Out points will be removed. If you’ve deleted part of a clip on Track 1, the Timeline will 
ripple to close the gap automatically.

(Top) Marking In and Out points to delete that section of the Timeline, (Bottom) After deleting whatever’s 
between the In and Out points, all clips to the right of the marked section move left to close the gap in Track 1

Trimming Clips
You can also quickly modify your edited timeline by resizing the In and Out points of any clip, 
moving the edit points between clips, and slipping the contents of a clip.

Resize Clips While Rippling the Timeline
If you move the pointer over the far left or right edge of a clip in the Timeline or Upper Timeline, 
it turns into a Resize icon to indicate that you can drag the In or Out point of that clip to make it 
shorter or longer, in the process rippling all clips to the right in the Timeline to accommodate 
the new length of the clip. While you drag, a white overlay in the Timeline lets you see how 
much media you have available for resizing (depending on the available handles in the source 
media). As you do so, the audio will scrub along with the Resize cursor.
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If you resize a clip in Track 1, the rest of the edited timeline automatically ripples to 
accommodate the changes you’ve made, with clips to the right of the changed area moving left 
to fill the gap of a deleted or shortened clips, or moving right to make room for an inserted or 
lengthened clip.

(Top) Clicking the Out point of clip DD in Track 1, (Bottom) Dragging 
to shorten clip DD ripples the Timeline; a tooltip appears to show 
you how many frames you’ve resized

Moving or resizing clips on Track 2 and above only moves or resizes that one clip; other clips in 
the Timeline are not rearranged and the Timeline is not rippled when you do this.

(Top) Clicking the out point of clip HH in Track 2, (Bottom) Dragging 
to lengthen the clip doesn’t ripple the Timeline

TIP: When you resize the Out point of a clip on Track 1 that’s underneath a 
superimposed clip, and the superimposed clip has an In point that’s to the right of the 
In point of the clip you’re resizing, then dragging the Out point of the clip you’re 
trimming past the left of the In point of the superimposed clip will delete that 
superimposed clip from the Timeline.

Rolling an Edit
You can click and drag any edit point between two clips in the Timeline or Upper Timeline to 
“roll” it, basically resizing the Out point of the outgoing clip and the In point of the incoming clip 
simultaneously. This lets you move an edit point without changing the duration of the overall 
timeline. While you drag, a white overlay in the Timeline lets you see how much media you have 
available for rolling (depending on the available handles in the source media). As you do so, the 
audio will scrub along with the right clip’s In point.
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(Top) Clicking an edit between clips CC and DD, (Bottom) Dragging 
to the right rolls it forward, simultaneously resizing clips CC and DD

Slipping Clip Content
If you move the pointer over any clip in the Timeline, a Slip handle appears at the center of the 
clip. Dragging this handle lets you slip the contents of that clip to present a different range of 
media, without changing the position or duration of the clip, and without changing any other 
part of the Timeline.

You can even select multiple clips, such as two superimposed clips, or a number of clips in a 
row, and slip them all at the same time. While you drag, a white overlay in the Timeline lets you 
see how much media you have available for slipping (depending on the source clip’s duration).

(Top) Clicking a clip’s slip handle, (Bottom) Dragging a clip’s slip 
handle to change the range of media within that clip

Trimming Edits in the Viewer
You can double-click any edit point between two clips in the Timeline or Upper Timeline to 
open up the Trim Editor, which provides a detailed method of adjusting both halves of an edit 
point. A graphical A/B roll interface shows two filmstrips with the outgoing clip on top and the 
incoming clip on the bottom. These controls are draggable:

�� Drag the left side of the top filmstrip’s handle to trim the Out point of the outgoing clip

�� Drag the right side of the bottom filmstrip’s handle to trim the In point of the 
incoming clip

�� Drag the white handle between the top and bottom filmstrips to roll the edit point, 
simultaneously adjusting the outgoing and incoming edit points
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Numbers over each frame let you see exactly how many frames you’re trimming, while a pair of 
buttons to the left and right of the transport controls in the Viewer toolbar let you adjust the 
outgoing clip’s Out point and incoming clip’s In point in one frame increments.

The Viewer Trim Editor seen when you double-click an edit in the Timeline

If you double-click a transition, that transition appears sandwiched between the outgoing and 
incoming clips, with handles you can use to trim the transition’s length and position, as well as 
the outgoing and incoming halves of the edit point to which the transition is applied.

The Viewer Trim Editor seen when you double-click a transition in the Timeline
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Chapter 22

Video and 
Audio Effects in 
the Cut Page

As you build your edit, you’ll often find it necessary to add effects to clips 
to create titles, blend clips together with compositing, add plug-ins to give 
clips a particular look, speed clips up or slow them down, or transform 
clips to zoom into them or move them around the frame. The Cut page has 
controls to accomplish all of this and more.
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Adding Transitions
You can add transitions such as dissolves or wipes to an edit to indicate a change of topic, a 
change of location, or the passage of time. You can also add a Smooth Cut transition to patch 
unwanted cuts in interview clips or other situations where there’s not a significant change in the 
position of the subject or background in the frame. Three buttons, at the bottom right of the 
Media Pool, make it easy to add and remove dissolves and Smooth Cut transitions.

The Cut, Dissolve, and Smooth Cut buttons

Adding Dissolves

Dissolves are the most standard and ubiquitous type of transition, and so they’re the easiest to 
create. Place the playhead on or near an edit you want to turn into a dissolve, and click the 
Dissolve button at the bottom left of the Media Pool. A one second Cross Dissolve will be 
added to the edit point that’s nearest to the edit point.

(Left) Moving a playhead near an edit point, (Right) Adding a dissolve

Adding Dissolve Using Keyboard Shortcuts
You can also add a dissolve by selecting one or more edit points (or moving the playhead near 
an edit you want to select and pressing V to select the nearest edit point), then pressing 
Command-T to add a dissolve, which is the standard transition.

A selected edit point

You can also add a transition that’s aligned with the beginning, middle, or end of the edit point 
using the keyboard. To do so, select an edit point, press the U key repeatedly to cycle among 
selecting the start, center, or end of the edit, then press Command-T to add the standard 
transition. The standard transition will be added with its alignment based on the edit selection 
you made; selecting the start of the edit places a transition that ends on the edit; selecting the 
end of the edit places a transition that starts on the edit, and choosing the center of the edit 
places a transition that is similarly centered.

A transition that’s aligned with the beginning, center, and end of an edit point
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Changing a Transition to a Cut
To remove a dissolve, thereby changing a transition to a cut, move the playhead at or near the 
edit with the dissolve, and click the Cut button, which is fast to do when you’re using the 
DaVinci Resolve Editor Keyboard which has a dedicated Cut button. 

TIP: Alternately, you can select one or more transitions in the Timeline and press the 
Delete key to remove them.

Adding Smooth Cuts
Smooth Cuts are special-purpose transitions designed to make short jump cuts in the middle of 
a clip unnoticeable. This is done by using optical flow processing to match the same features on 
either side of a cut in order to automatically morph a subject from one position to another over 
the duration of the transition.

To add a Smooth Cut:
1	 Place the playhead on or near an edit.

2	 Click the Smooth Cut button at the bottom left of the Media Pool. A one second Smooth 
Cut will be added to the edit point that’s nearest to the edit point.

The Smooth Cut effect works best on clips such as sit-down interviews and close-up head 
shots with a minimum of background and subject motion, and where the subject’s position on 
either side of the cut is not significantly different. A good example of when Smooth Cut is 
effective is when you’re cutting pauses, partial repeats, filler sounds such as “um” or “you 
know,” or other speech disfluencies out of an interview clip to tighten the dialog, and you want 
to eliminate the little “jump” that occurs at the cut without having to cut away to B-roll. Applying 
a short two or four frame Smooth Cut transition to the edit can make this kind of edit invisible, 
as long as the speaker doesn’t change position significantly during the cut. The more motion 
there is in the background of the shot, and the more the speaker changes position, the harder it 
will be to get a useful result using Smooth Cut. Although the default duration for any transition is 
one second, you’ll find that Smooth Cut transitions may work much better when they’re short; 
2- to 6-frame Smooth Cut transitions often work best to disguise jump cuts.

Adding Other Kinds of Transitions
Opening the Transitions browser by clicking the Transitions button in the UI toolbar reveals all 
of the built-in transitions that accompany DaVinci Resolve, as well as any third-party OFX 
transitions that you have installed on your computer. These transitions are organized by 
categories such as Dissolve, Iris, Motion, Shape, and Wipe. 
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The Transitions Browser lets you choose different 
transitions for creative effects

Methods of adding different transitions by drag and drop:
�� To add a transition by dragging it from the Transitions Browser: Drag a video 

transition from the Effects Library to an edit point in the Timeline so that it’s centered at, 
ends at, or starts at the edit point. If there is no overlap between the heads and tails of 
the two clips, you may not be able to add a transition where you want.

�� To add a transition using the Transitions Browser’s contextual menu: Select one or 
more edit points (one per track), then right-click a video transition in the Effects Library 
and choose Add to Selected Edit Points. That transition will be added to every selected 
edit point at once.

Editing and Removing Transitions
Once you’ve added a transition, you can edit it in a number of different ways to work best for 
your program.

Methods of editing transitions:
�� To change a transition’s duration: Drag the beginning or end of a transition in the 

Timeline to be longer or shorter symmetrically about the current edit.

�� To move a transition from one edit to another: You can drag a transition from its 
current position to another edit point.

�� To copy a transition from one edit to another: Select a transition, then option-drag it to 
another edit point to add a duplicate transition.

�� To change a transition’s type: Drag a different transition from the Transition Browser 
onto the current one in the Timeline.

�� To remove a transition: Select a transition in the Timeline and press the Delete key.
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Titles
There’s a collection of title clips in the Titles Browser that you can use to add superimposed 
titles, slates, interstitial titles, lower thirds, or otherwise fulfill any textual needs your program 
has. Two categories present two different kinds of titles.

The available titles in the Titles Browser

The “Titles” category presents simple, bare-bones titles that you can customize in a variety of 
different ways. Of the available options, the Text title is the most flexible. The “Fusion Titles” 
category presents more complicated titles that are more visually sophisticated and have more 
preset animation.

Adding Titles
You can add a title to the Timeline by opening the Titles Browser and dragging and dropping 
titles into the Timeline wherever you want them to be, just like any other clip. The default 
duration of a title clip is 5 seconds. This standard “generator” duration can be customized in the 
Editing panel of the User Preferences.

Once edited into the Timeline, titles can be moved, resized, and superimposed much like any 
other clip. Furthermore, when selected, both titles and generators expose the same Transform, 
Cropping, Speed, and Composite controls as any other clip; these controls can be used to 
composite titles in various ways to create different text effects.

Editing Titles
Once you add a title to the Timeline, the original title generators that shipped with 
DaVinci Resolve have onscreen controls that let you edit text and transform and position blocks 
of text directly within the Timeline Viewer.
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Positioning and Transforming Text
So long as the Timeline playhead is positioned over a text generator that’s on top of one or 
more background clips, clicking on the text in the Timeline Viewer reveals onscreen transform 
controls that correspond to the Position, Zoom, and Rotation parameters in the Inspector.

Transforming a title’s text box in the Viewer

While dragging text to reposition it, snapping occurs at the X and Y center of the frame, as well 
as around the outer third of the frame. Holding the Shift key down while dragging a text object 
constrains movement to just the X or Y axes. Holding the Option key down turns snapping off.

Editing Text
Double-clicking on text in the Timeline Viewer puts that text into an editable state, wherein you 
can insert a text cursor or select characters to edit the text as you would in any text editor.

Editing the text of a title in the Viewer

Editing Titles Using the Floating Inspector
There are a variety of other title parameters you can adjust using the floating inspector that’s 
available when you click the Viewer’s Tools button, and then click the Text control and Open 
Inspector button.

Clicking the Tools button reveals the Text control and Open Inspector button

Clicking Open Inspector reveals the floating inspector, which lets you adjust all of the other 
parameters available for the title you’ve edited into the Timeline. When you’ve finished making 
adjustments, close this window.
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The floating text Inspector

Adding ResolveFX and Other Plug-ins
The Filters browser reveals video and audio plug-ins that you can drag and drop onto to your 
clips. As far as video plug-ins go, there are several categories of ResolveFX plug-ins that 
accompany DaVinci Resolve, but if you’ve installed Resolve-compatible OFX plug-ins, those 
appear here as well, organized into their own categories. For audio plug-ins, a set of FairlightFX 
plug-ins comes with DaVinci Resolve, but if you’ve installed VST plug-ins on macOS or 
Windows, or you have Audio Units installed on macOS, those will appear in the Audio category 
also. When you have a lot of video or audio plug-ins, a search field makes it easy to find the one 
you’re looking for.

The available plug-ins in the Effects browser

Chapter – 22  Video and Audio Effects in the Cut Page 454



Video Plug-ins
Each available category of video plug-ins creates different sorts of image effects, such as blurs, 
lighting effects, or stylization of different kinds. To use, simply drag and drop any video plug-in 
onto a video clip. If you select multiple clips and drag a plug-in onto one of the selected clips, 
that plug-in will be added to all of them. When a clip in the Timeline has a plug-in applied to it, a 
badge appears on that clip.

A clip in the Timeline with a plug-in applied has an “fx” badge

Audio Plug-ins
Audio plug-ins let you process your audio in different ways, adjusting the tone using 
equalization, changing dynamics with compression, or adding effects such as echo, reverb, 
flange, or modulation. To use, simply drag and drop any audio plug-in onto a video+audio or 
audio-only clip. If you select multiple clips and drag a plug-in onto one of the selected clips, that 
plug-in will be added to all of them.

Editing Plug-ins
Every video and audio plug-in can have its effect adjusted using a variety of parameters that 
are available in the floating inspector that appears when you click the Viewer’s Tools button, 
and then click the Open Inspector button.

Clicking the Tools button reveals the plug-in control and Open Inspector button

Clicking Open Inspector reveals the floating inspector, which lets you adjust all of the other 
parameters available for the title you’ve edited into the Timeline. When you’ve finished making 
adjustments, close this window.

The floating plug-in Inspector
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Clip Effects
Clicking the Tools button in the Viewer toolbar opens up additional categories of controls that 
let you apply various effects to the current clip, or adjust whatever effect is already applied to 
the current clip. Many of the parameters of these effects have corresponding onscreen controls 
that let you make visual adjustments directly in the Viewer.

The Tools button

Shared Controls
Every category of effect at the bottom of the Viewer has two shared controls. A toggle control 
at the far left lets you enable or disable an effect without losing whatever custom adjustments 
you’ve made. A reset control at the far right lets you reset every parameter within a particular 
category of controls to the default settings.

The Toggle button (at left) and Reset button (at right)

Transform Effects
When you select Transform Effects, onscreen transform controls appear that let you directly 
manipulate the image in the Viewer. You can drag anywhere within the clip’s bounding box to 
adjust pan and tilt, drag any diagonal corner to proportionally resize, drag any top/bottom/left/
right side to squeeze or stretch width or height, or drag the center handle to rotate. These 
parameters are also editable in the Edit page Inspector and the Color page Edit Sizing palette.

Onscreen Transform controls in the Viewer

TIP: While dragging a clip using the onscreen controls to reposition it, holding the Shift 
key down constrains movement to just the X or Y axes.

The onscreen controls also correspond to the following editable parameters, which are also 
editable in the Edit page Inspector and in the Edit Sizing mode of the Sizing palette in the 
Color page:

�� Zoom Width and Height: Allows you to blow the image up or shrink it down. The X and 
Y parameters can be linked to lock the aspect ratio of the image, or released to stretch 
or squeeze the image in one direction only.

�� Position X and Y: Moves the image within the frame, allowing pan and scan 
adjustments to be made. X moves the image left or right, and Y moves the image 
up or down.
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�� Rotation Angle: Rotates the image around the anchor point.

�� Pitch: Rotates the image toward or away from the camera along an axis running through 
the center of the image, from left to right. Positive values push the top of the image 
away and bring the bottom of the image forward. Negative values bring the top of the 
image forward and push the bottom of the image away. Higher values stretch the image 
more extremely.

�� Yaw: Rotates the image toward or away from the camera along an axis running through 
the center of the image from top to bottom. Positive values bring the left of the image 
forward and push the right of the image away. Negative values push the left of the 
image away and bring the right of the image forward. Higher values stretch the image 
more extremely.

�� Flip Image: Two buttons let you flip the image in different dimensions.

–– Flip Horizontal control: Reverses the image along the X axis, left to right.

–– Flip Vertical control: Reverses the clip along the Y axis, turning it upside down.

Crop Effects
The Cut page has a set of onscreen controls you can use to directly crop the image in the 
Viewer. Each side of the image has an individual handle for cropping just that side. These 
parameters are also editable in the Edit page Inspector and the Color page Sizing palette.

 

Onscreen Crop controls in the Viewer

The Crop effects also correspond to an additional set of cropping parameters, with an 
additional control for softness:

�� Crop Left, Right, Top, and Bottom: Lets you cut off, in pixels, the four sides of the 
image. Cropping a clip creates transparency, so whatever is underneath shows through.

�� Softness: Lets you blur the edges of a crop. Setting this to a negative value softens the 
edges inside of the crop box, while setting this to a positive value softens the edges 
outside of the crop box.

Audio Levels
A slider lets you adjust audio levels of the current clip in the Viewer, making the volume of that 
audio clips softer or louder. This is identical to each clip’s volume setting in the Edit and 
Fairlight pages.

Onscreen Crop controls in the Viewer toolbar

Speed Effects
Speed effects let you speed up, slow down, or otherwise change the playback speed of clips in 
the Timeline. When you change the speed of a clip, that clip’s duration also changes to reflect a 
shorter clip that plays faster, or a longer clip that plays more slowly. Speed effects change both 

Chapter – 22  Video and Audio Effects in the Cut Page 457



video and audio playback, but the audio of sped up or slowed down clips is always pitch 
corrected. Speed effects applied in the Cut page also appear and are editable via several 
different methods in the Edit page timeline.

Speed Effects controls in the Viewer toolbar

�� Speed: Changing this value lets you speed up or slow down playback by a simple 
numeric multiplier. You also have the option of choosing a negative value to create 
reverse speeds.

�� Duration: When you retime a clip, the Duration field lets you see how the change you’re 
making affects the new duration based on the original duration of the clip with no 
speed effect applied.

�� Easing buttons: These buttons let you change the easing of the speed effect so that 
you can ease into or out of a speed effect from normal speed. There are four options: 
Linear, Ease In, Ease In and Ease Out, and Ease Out.

�� Ghosting and Optical Flow Speed Processing buttons: Two buttons let you choose 
how the retimed clip is processed in order to improve its visual playback quality, 
especially in the case of clips that are slowed down, but also for clips that are sped up. 
Ghosting adds dissolves between adjacent frames to interpolate the difference. Optical 
Flow uses motion estimation to generate new frames from the original source frames 
to create slow or fast motion effects, producing smooth when motion (note that moving 
elements crossing in different directions or unpredictable camera movement can cause 
unwanted artifacts with Optical Flow processing).

Camera
The Camera controls give you access to Stabilization and Lens correction controls, available by 
clicking the buttons within. When you’re within the Stabilization controls or Lens Correction 
controls themselves, a Close button takes you back to this top level.

Stabilization and Lens Correction controls in the Viewer toolbar

Stabilization Controls
The Image Stabilization controls use warping and/or translation to let you smooth out or even 
lock unwanted camera motion within a clip. The analysis is performed in such a way as to 
preserve the motion of individual subjects within the frame, as well as the overall direction of 
desirable camera motion, while correcting for unsteadiness.

Stabilization controls in the Viewer toolbar

To stabilize an image, all you need to do is to choose a Stabilization Method from the pop-up 
(see below for more information), and then click the Stabilize button. DaVinci Resolve analyzes 
the current clip, and applies a stabilization effect.
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The rest of the stabilization controls let you refine the result. Whenever you adjust any of these 
parameters, you must click the Stabilize button again for the effect to be updated.

�� Stabilization Method: A pop-up menu provides three different options that determine 
how the selected clip is analyzed and transformed during stabilization. You must 
choose an option first, before clicking the Stabilize button, because the option you 
choose changes how the image analysis is performed. If you choose another option, 
you click the Stabilize button again to reanalyze the clip.

–– Perspective: Enables perspective, pan, tilt, zoom, and rotation analysis and 
stabilization.

–– Similarity: Enables pan, tilt, zoom, and rotation analysis and stabilization, for 
instances where perspective analysis results in unwanted motion artifacts.

–– Translation: Enables pan and tilt analysis and stabilization only, for instances where 
only X and Y stabilization gives you acceptable results.

�� Camera Lock: Turning on this checkbox disables Cropping Ratio and Smooth, and 
enables the stabilizer to focus on eliminating all camera motion from the shot in an 
effort to create a locked shot.

�� Zoom: When this checkbox is turned on, the image is resized by a large enough 
percentage to eliminate the blanking (black edges) that is the result of warping and 
transforming the image to eliminate unwanted camera motion. The lower a value 
used for Cropping Ratio, the more DaVinci Resolve will need to zoom into an image to 
eliminate these blanked edges.

�� Cropping Ratio: This value limits how hard the stabilizer tries to stabilize, by dictating 
how much blanking or zooming you’re willing to accept in exchange for eliminating 
unwanted motion. A value of 1.0 results in no stabilization being applied. Progressively 
lower values enable more aggressive stabilization. Changing this value requires you to 
click the Stabilize button again to reanalyze the clip.

�� Smooth: Lets you apply mathematical smoothing to the analyzed data used to stabilize 
the clip, allowing camera motion in the shot while eliminating unwanted jittering. Lower 
values perform less smoothing, allowing more of the character of the original camera 
motion to show through, while higher values smooth the shot more aggressively. 
Changing this value requires you to click the Stabilize button again to reanalyze the clip.

�� Strength: Lets you choose how tightly you want to use stabilization to eliminate motion 
from a shot. With a value of 1, stabilization is maximized in an effort to “lock” the shot 
in place and eliminate all camera motion. This value is a multiplier. Since some clips 
might look more natural with looser stabilization, choosing a number lower than 100 
lets a percentage of the original camera motion show through. Negative 1 (-1) disables 
stabilization altogether.

�� Stabilize: Clicking this button on a previously unstabilized clip analyzes the motion 
in that clip and applies an initial smoothing effect. Clicking this button on a clip that’s 
already been analyzed lets you recalculate a modified stabilization effect after you’ve 
adjusted the Camera Lock, Zoom, Cropping Ratio, Smooth, or Strength settings.

�� Close: Clicking this button takes you back to the overall Camera controls.

TIP: These controls are identical to those found in the Edit page Inspector and the 
Color page Tracker palette, and populate the same image processing data. This means 
that you can use the Stabilization found on the Cut page, and then use the stabilization 
graph and controls found in the Color page to refine the results, if necessary.
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Lens Correction Controls
Lens Correction presents two controls that let you either correct lens distortion in the image, or 
add lens distortion of your own for effect. These controls are also editable in the Edit page 
Inspector and Color page Edit Sizing palette.

Lens Correction controls in the Viewer toolbar

�� Analyze: Automatically analyzes the frame in the Timeline at the position of the 
playhead for edges that are being distorted by wide angle lens. Clicking the Analyze 
button moves the Distortion slider to provide an automatic correction. If you’re 
analyzing a particularly challenging clip, a progress bar will appear to let you know how 
long this will take.

�� Distortion: Dragging this slider to the right lets you manually apply a warp to the image 
that lets you straighten the bent areas of the picture that can be caused by wide angle 
lenses. If you clicked the Analyze button and the result was an overcorrection, then 
dragging this slider to the left lets you back off of the automatic adjustment until the 
image looks correct.

�� Close: Clicking this button takes you back to the overall Camera controls.

Dynamic Zoom
The Dynamic Zoom controls, which are off by default, make it fast and easy to do pan and scan 
effects to zoom into or out of a clip. A set of two onscreen controls let you create a Dynamic 
Zoom effect. A green box shows the starting size and position of the animated transform, while 
a red box shows the ending size and position of the animated transform. Drag anywhere within 
either bounding box to reposition either the start or the end of the animated effect, and drag 
any of the corners to adjust the size at the start or end. A motion path appears to show you 
motion that’s being created. Adjusting the Dynamic Zoom controls automatically enables 
Dynamic Zoom.

Dynamic Zoom controls in the Viewer

These controls correspond to two parameters in the toolbar (Dynamic Zoom is also editable in 
the Edit page Inspector).

�� Zoom/Pan/Angle Presets: Let you enable or disable preset positions for the zoom 
level, pan location, and angle of this effect.

�� Swap: This button reverses the start and end transforms that create the dynamic zoom 
effect.

�� Ease Buttons: Lets you choose how the motion created by these controls accelerates. 
You can choose from Linear, Ease In, Ease Out, and Ease In and Out.

TIP: While dragging dynamic zoom outlines to reposition them, holding the Shift key 
down constrains movement to just the X or Y axis.
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Composite Effects
Two controls let you create transparency and use composite modes to create different 
compositing effects (also called Blend modes or Transfer modes). These controls also editable 
in the Edit page Inspector.

Stabilization controls in the Viewer toolbar

�� Composite Modes: Composite modes blend two superimposed clips together on 
the Timeline using different kinds of math to achieve differing results, to create 
transparency effects, increase image exposure, and combine multiple clips into a single 
image in many creative and useful ways. All Composite modes interact with the Opacity 
slider. For more information on what each Composite mode does, see Chapter 41, 
“Compositing and Transforms in the Timeline.”

�� Opacity: This slider lets you make a clip more transparent, over a range from 0 (totally 
transparent) to 100 (totally opaque). When set to a value less than 100, the selected clip 
is mixed with whatever video clip is underneath it on the Timeline, using the Composite 
mode that’s currently selected. If no clip appears underneath the Timeline, then the clip 
is mixed with black and will work similarly to a fade.

TIP: If a superimposed video or still image clip in the Timeline has an alpha channel, 
that alpha channel automatically creates transparency within that clip, compositing it 
against whatever is in the track underneath. There’s no need for you to do anything for 
this to work. 
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Chapter 23

Quick Export

Once you’ve finished your program and you want to share it with others, 
you can use the Quick Export button to output the contents of the 
Timeline as a self-contained file in one of a variety of different formats in 
order to share it with people.
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Quick Export
You can choose File > Quick Export to use one of a variety of export presets to export your 
program from any page of DaVinci Resolve. You can even use Quick Export to export and 
upload your program to one of the supported video sharing services, including YouTube, 
Vimeo, and Frame.io. 

To use Quick Export:
1	 In the Edit, Fusion, or Color page, optionally set In and Out points in the Timeline to 

choose a range of the current program to export. If no timeline In or Out points have 
been set, the entire timeline will be exported.

2	 Choose File > Quick Export or click the Quick Export icon at the upper right-hand 
corner of the Cut page.

3	 Select a preset to use from the top row of icons in the Quick Export dialog, 
and click Export.

4	 Choose a directory location and enter a file name using the Export dialog, then click 
Save. A progress bar dialog appears to let you know how long the export will take.

The Quick Export dialog
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Customizing Quick Export
While the Quick Export has, by default, a variety of the most important formats currently in use 
for sharing video files, you may need to export to a format that’s not in this dialog. In this case, 
there are ways of creating additional presets and having them appear in the Quick 
Export dialog.

To customize Quick Export:
1	 Open the Deliver page.

2	 Create the preset you want to add using the Render Settings panel.

3	 Click the Render Settings panel’s Option menu and choose the preset or presets 
you want to add from the Quick Exports submenu so that they’re checked. You can 
also remove your own presets from the Quick Export window by unchecking them in 
this menu.

Adding presets to the Quick Export dialog

TIP: For more export options, you can also use the Deliver page
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Chapter 24

Using the 
DaVinci Resolve 
Editor Keyboard

The DaVinci Resolve Editor Keyboard is a combination of Keyboard and 
Edit Controller that greatly enhances your speed and efficiency working in 
DaVinci Resolve.
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Introducing the DaVinci Resolve 
Editor Keyboard
Using a traditional keyboard and mouse to edit with is necessary for modern computers, as the 
interface and operating system dictate the use of these input tools. However, the mouse can 
sometimes feel like an abstraction in the editing process, and the DaVinci Resolve Editor 
Keyboard has been designed to bring back a more “hands on” feel. This keyboard allows the 
convenience and power of non-linear editing with the tactile nature of the tape-based edit 
controllers of the past.

This hybrid editing style is based around the concept of the “timeline edit point.” An edit point is 
simply the junction between two edit points that is closest to the playhead on the Timeline. This 
edit point can either be before or after the playhead, and the playhead does not need to be on 
the actual point itself, just near it. DaVinci Resolve’s Cut Page will automatically assume the edit 
point for you, and shows you where it intends to make the edit using a Smart Indictor, which 
looks like a small arrow on the Timeline Ruler.

The Cut Page Timeline’s Smart Indicator (circled) 
showing the timeline edit point.

The key to making this style of editing fast and efficient is the speed at which you arrive at 
these timeline edit points. The DaVinci Resolve Editor Keyboard has been designed to greatly 
accelerate timeline navigation and to use a two-handed workflow with dedicated buttons for 
common functions in order to keep your mouse use to a minimum. 

The DaVinci Resolve Editor Keyboard
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Navigation Using the Search Dial
The most prominent feature of the DaVinci Resolve Editor Keyboard is the large Search Dial on 
its right hand side. Primarily used for navigation, in certain circumstances this dial can also be 
used for the manipulation of the clips, providing an alternative to click and drag mouse input.

The Search Dial and 
Navigation buttons

Since navigation of the Timeline is where most editors spend the majority of their time, you will 
want to decide on how the playhead reacts on the Timeline. In the Cut page you have two 
options: Lock or Free Playhead.

�� When set to Locked, the playhead is fixed in the center of the Timeline, and your edited 
clips scroll past it as you play (press the Spacebar), jog, or shuttle with the Search Dial 
in either direction. Locked mode is preferred while using the DaVinci Resolve Editor 
Keyboard.

�� When set to Free, the playhead moves across the clips as you play (press the 
Spacebar), jog, or shuttle using the Search Dial in either direction; the clips stay still. 
Once the playhead gets to the right or left edge of the Timeline, the Timeline pages 
over to reveal the next part of your edit.

Playhead Lock controls

Source
Pressing this button instantly brings the Source Viewer into focus, allowing you to navigate 
through the source media.

Timeline
Pressing this button instantly brings the Timeline Viewer into focus, allowing you to navigate 
through the timeline.
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SHTL (Shuttle)
Puts the Search Dial into Shuttle mode. Used to quickly navigate long clips or sync bins. 
Rotating the dial left of center “rewinds” through the clip or timeline, rotating it right “fast 
forwards” through them. The greater the rotation from center, the faster the Shuttle goes. There 
are hard end stops on the Search Dial in Shuttle mode that indicate the maximum speed in 
either direction. A LED on the keyboard will illuminate to show you that this mode is selected.

Jog
Puts the Search Dial into Jog mode. Used to navigate to specific frames with accuracy and 
precision. Traditionally, you place your finger the the Search Dial dimple, and rotate it to the left 
to go frame by frame reverse, and to the right to go frame by frame forward. In Jog mode the 
hard stops are released, and the wheel rotates freely in a complete circle. A LED on the 
keyboard will illuminate to show you that this mode is selected.

SCRL (Scroll)
Puts the Search Dial into Scroll mode. Scroll mode is essentially a “higher geared” jog mode. 
Rotating the wheel left reverses the play direction, while rotating it right moves forward. Scroll 
works in terms of seconds rather than frames. The speed at which you rotate the Search Dial 
determines how fast the playhead moves through the footage. A LED on the keyboard will 
illuminate to show you that this mode is selected.

Sort Media Pool Buttons
These buttons allow you to instantly re-configure the Media Pool view to arrange your clips in a 
specific order.

The Media Pool Sort buttons

Timecode
Pressing this button will instantly sort all of the clips in the Media Pool by Timecode. Pressing 
this button again will toggle between ascending and descending order.

CAM (Camera)
Pressing this button will instantly sort all of the clips in the Media Pool by Camera Number order. 
The camera numbers can be set in the Clips Metadata Editor field “Camera #”. This field can 
either be a number or a letter. Pressing this button again will toggle between ascending and 
descending order.
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Date/Time
Pressing this button will instantly sort all of the clips in the Media Pool by the Date and Time that 
the clip was created. Pressing this button again will toggle between ascending and 
descending order.

Clip Name
Pressing this button will instantly sort all of the clips in the Media Pool by Clip Name. Please 
note this sorts media by the user selected Clip Name, not the media’s File Name that is 
recorded in camera. Pressing this button again will toggle between ascending and 
descending order.

Editorial Tools
The DaVinci Resolve Editor keyboard has dedicated keys to perform common editing functions, 
in addition to the standard QWERTY keyboard.

The Cut page Editing tools

In
This button selects the In point of a clip or timeline.

Out
This button selects the Out point of a clip or timeline.

Smart Insert
Automatically inserts an incoming clip at the closest edit point to the playhead (as shown by the 
Smart Indicator) on the selected track, pushing all clips to the right of the edit point forward to 
make room for the incoming clip you’ve inserted to Track 1. Because this is a smart operation, 
you are prevented from inserting a clip at any arbitrary frame; incoming clips are only inserted at 
the closest previously existing edit point.
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(Top) Before doing a Smart Insert, (Bottom) After inserting clip DD 
between clips AA and BB

Append
The position of the playhead is ignored; incoming clips are always placed after the last clip in 
the Timeline.

Performing an Append edit of clip DD to the Timeline

RIPL O/WR (Ripple Overwrite)
At its simplest, Ripple Overwrite substitutes a clip in the Timeline with an incoming clip. If you 
use Ripple Overwrite on a clip on Track 1, this will automatically move all clips that are to the 
right of the affected clip in the Timeline either forward to make room if the incoming clip is 
longer, or back to eliminate gaps if the incoming clip is shorter. 

Performing a Ripple Overwrite to substitute an entire clip at the 
playhead (BB) with the incoming clip (DD)
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Close Up
Lets you edit a clip into the Timeline as a zoomed-in close up to make up for a lack of actual 
close ups that would have been shot with either longer lenses or by moving the camera closer 
to the subject. This function is particularly useful when you’re working with 4K media in a 1080 
timeline, or 8K media in a 4K timeline, which enables you zoom into existing wide shots to 
create medium shots, or medium shots to create close up shots, with no loss of quality. 

Performing this edit adds the incoming clip as an approximate 150% scaled close up, also 
performs a face detection, and if a face or faces are found automatically re-positions the face in 
the frame. Which frame of the Timeline the incoming clip aligns with depends on the following:

�� If no In or Out points are set on the Timeline, the incoming clip aligns with the Timeline 
playhead as the In point.

�� The incoming clip aligns with a timeline In point if one has been set.

�� The incoming clip’s Out point will align with a timeline Out point if one has been set 
without an In point. This “backtimes” the clip.

(Top) Before a Close Up edit, (Bottom) After editing clip DD 
into the Timeline with a Close Up edit Place on Top

Place On Top
Lets you edit the incoming clip as a superimposition above whatever other clips are in the 
Timeline; the incoming clip is always placed on top, so if there are clips in Tracks 1, 2, and 3, the 
incoming clip is automatically placed on Track 4, regardless of which track is selected. The 
frame the incoming clip aligns with depends on the following:

�� The incoming clip aligns with the closest Timeline edit point in proximity to the 
playhead (as shown by the Smart Indicator) if no timeline In or Out points have been 
defined. The playhead is ignored.

�� The incoming clip aligns with a timeline In point if one has been set.

�� The incoming clip’s Out point will align with a timeline Out point if one has been set 
without an In point. This “backtimes” the clip.

(Top) Before placing a clip on top, (Bottom) After editing 
clip DD into the timeline with a Place on Top edit
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SRC O/WR (Source Overwrite)
This edit requires overlapping timecode in multiple clips to work properly, such as when 
recording synced timecode to multiple cameras during a multi-cam shoot. If there is no 
overlapping timecode, this edit does nothing.

If you are working with footage from multiple cameras that have synced timecode, then the 
easiest way to use this edit type is to set In and Out points over a clip in the Timeline where you 
want to cut away to another angle. In the following example, a wide shot of a cooking show 
covers the moment when the chef starts slicing a chili.

Setting Timeline In and Out points to identify a cutaway

You can then select a clip in the Media Pool that corresponds to the desired angle you want to 
add as a cutaway, which has synced timecode that overlaps with the clip in the Timeline. Don’t 
set In and Out points; if necessary, you can clear previously set In and Out points by 
pressing Option-X.

Choosing a Media Pool clip from another camera 
that has overlapping timecode

When you click the Source Overwrite button, a synced section of the selected Media Pool clip 
will be edited into the Timeline between the In and Out points you placed, superimposed on 
top. The result is a perfectly timed cutaway.

Using Source Overwrite to edit a superimposed and synced section 
of the source clip into the Timeline between the In/Out points
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Alternatively, you can also use Source Overwrite to automatically place a source clip with a 
marked In/Out region on top of a clip in the Timeline so that its timecode syncs with the 
timecode of the timeline clip, when you don’t know exactly how much of the incoming source 
clip you want to edit into the Timeline, and you just want it synced appropriately.

Trimming Tools
Several of the most powerful features of the DaVinci Resolve Editor Keyboard involve the 
intuitive trimming controls afforded by the Search Dial.

The Trimming tools

Trim In
When this key is pressed and held, it lets the user trim the nearest In point on the Timeline (as 
shown by the Smart Indicator), by simply rotating the Search Dial back and forth. The trim point 
is highlighted in green. Release the key to confirm the edit.

Trim Out
When this key is pressed and held, it lets the user trim the nearest Out point on the Timeline (as 
shown by the Smart Indicator), by simply rotating the Search Dial back and forth. The trim point 
is highlighted in green. Release the key to confirm the edit.

Roll
When this key is pressed and held, it lets the user trim the nearest transition point (as shown by 
the Smart Indicator), and roll the edit point back and forth between the clips by simply rotating 
the Search Dial. The trim point is highlighted in green. Release the key to confirm the edit.

SLIP SRC (Slip Source)
When this key is pressed and held, it allows the user to slip the footage of the clip to the left of 
the Smart Indicator back and forth by moving the Search Dial. A four way multiview will show 
the In and Out points for both source and destination clips as you slip. The clip that will slip will 
be highlighted in orange. Release the key to confirm the edit.
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SLIP DEST (Slip Destination)
When this key is pressed and held, it allows the user to slip the footage of the clip to the right of 
the Smart Indicator back and forth by moving the Search Dial. A four way multiview will show 
the In and Out points for both source and destination clips as you slip. The clip that will slip will 
be highlighted in orange. Release the key to confirm the edit.

Trim Editor
This button near the Timecode keypad places the Cut page into the Trim Editor mode in the 
Viewer. The current transition point is highlighted in green. You can navigate from transition 
point to transition point in the Timeline by rotating the Search Dial. Pressing the U key will cycle 
through the edit point types for your trim. 

Transition Keys
This set of keys provide immediate shortcuts to the most commonly used transition commands.

Transition keys

Cut
This key will set a simple cut at the Timeline edit point, as shown by the Smart Indicator. If there 
is another transition already present there, it will replace it.

DIS (Dissolve)
This key will add a one second dissolve centered between the two shots at the Timeline edit 
point, as shown by the Smart Indicator. If there is another transition already present there, it will 
replace it.

SMTH CUT (Smooth Cut)
This key will add a Smooth Cut transition centered between the two shots at the Timeline edit 
point, as shown by the Smart Indicator. If there is another transition already present there, it will 
replace it.

Smooth Cuts are special-purpose transitions designed to make short jump cuts in the middle of 
a clip unnoticeable. This is done by using optical flow processing to match the same features on 
either side of a cut in order to automatically morph a subject from one position to another over 
the duration of the transition. 
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The Smooth Cut effect works best on clips such as sit-down interviews and close-up head 
shots with a minimum of background and subject motion, and where the subject’s position on 
either side of the cut is not significantly different. A good example of when Smooth Cut is 
effective is when you’re cutting pauses, partial repeats, filler sounds such as “um” or “you 
know,” or other speech disfluencies out of an interview clip to tighten the dialog, and you want 
to eliminate the little “jump” that occurs at the cut without having to cut away to B-roll. Applying 
a short two or four frame Smooth Cut transition to the edit can make this kind of edit invisible, 
as long as the speaker doesn’t change position significantly during the cut. The more motion 
there is in the background of the shot, and the more the speaker changes position, the harder it 
will be to get a useful result using Smooth Cut. Although the default duration for any transition is 
one second, you’ll find that Smooth Cut transitions may work much better when they’re short; 
2- to 6-frame Smooth Cut transitions often work best to disguise jump cuts. 

TRANS DUR (Transition Duration)
Holding down this key when a transition is under the Smart Indicator will allow you to change 
the duration of the transition using the Search Dial. Turning the dial left will shorten the 
transition, and right will lengthen it. Once the duration is correct, release the button.

Function Keys
The function keys of the DaVinci Resolve Editing Keyboard are by default mapped directly to 
their DaVinci Resolve commands. If you wish to use them as regular function keys (f1, f2, f3, etc.) 
you can hold the Fn key down and press the appropriate function key.

The mapped Function keys

Sync Bin (F1)
This key will open up the Sync Bin for easy multi-camera editing as described in Chapter 20, 
“Fast Editing in the Cut Page” There is, however, a specific function in the Sync Bin that works 
only with the DaVinci Resolve Editing Keyboard, called Live Overwrite.
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Live Overwrite
When editing in the Sync Bin you can “paint on” a specific camera angle to the Timeline and 
adjust its duration using the Search Dial.

1	 Navigate the Timeline so the playhead is where you want the new camera angle to 
start. This function does not edit at the Smart Indicator; the edit point is exactly where 
the playhead is positioned.

2	 Hold down the number of the camera you want in the multi viewer on the keyboard, 
and rotate the Search Dial to the right to adjust the duration forward or to the left 
to go backward.

3	 Release the number key to perform the edit.

At this point the Timeline is instantly set up at the correct point to do the next edit, so repeat 
Step 2 and Step 3 again with different camera angles until you are finished. 

This is an incredibly quick and intuitive way to edit multi-camera productions.

Live Overwriting a Multi-camera shoot

Insert Black (F2)
Pressing this button will add two seconds of black (via the solid color generator) to the selected 
track. This is used as filler for transitions where you want to replace the “nothing” of the empty 
timeline with an actual media clip. This function does not use the Smart Indicators and will insert 
exactly at the playhead position.  

Freez (Freeze Frame) (F3)
Pressing this button will freeze the exact frame of the clip that is under the playhead for the 
remaining duration of that clip.

TRANS (Transition) (F4)
Holding down this key brings up a pop-up menu of your available transitions in alphabetical 
order and an icon describing their shape. Rotating the Search Dial left and right will navigate 
you through the list. When you find the transition that you want, simply release this key and it 
will be placed at the Timeline edit point as shown by the Smart Indicator.
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Pop-Up Transition menu

Pic in Pic (Picture in Picture) (F5)
Holding this button down will open a pop-up menu that displays four picture-in-picture 
placement options that you can navigate using the Search Dial or numeric keyboard. This 
function will take the media that is in the Source Viewer, scale it to 1/8 size and place it on top of 
the original clip in the position that was selected in the pop-up menu. If you wish to change the 
pop-up position, navigate over the clips, hold down this button and select another position.

Picture-in-Picture options

Swap (F6)
Press and hold the Swap button and using the Search Dial move the clip under the playhead 
earlier or later in the timeline, effectively swapping the moving clip with the one you are 
scrolling over.

Video Only (F7)
This button locks the audio tracks in place on the Timeline so that all further editing is done 
with the video tracks only. Press this button again to release the audio tracks, or press the 
Audio Only button.
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Audio Only (F8)
This button locks the video tracks in place on the Timeline so that all further editing is done 
with the audio tracks only. Press this button again to release the video tracks, or press the 
Video Only button.

Insert (F9)
An Insert edit splits whatever media is already in the Timeline at the position of the playhead 
and pushes that media to the right to make room for the incoming clip.

O/WR (Overwrite) (F10)
You can use the F10 key to perform an Overwrite edit, which overwrites a section of the 
Timeline with the incoming clip, without moving other clips in any way. The frame the incoming 
clip aligns with depends on the following:

�� The incoming clip aligns with the playhead if no timeline In or Out points 
have been defined.

�� The incoming clip aligns with a timeline In point if one has been set.

�� The incoming clip’s Out point will align with a timeline Out point if one has been set 
without an In point. This “backtimes” the clip.

REPL (Replace) (F11)
Replace edits are a unique three-point edit type that aligns the frame at the Source Viewer playhead 
with the frame at the Timeline playhead when the edit is executed. This is the fastest edit type 
to use when you need to align an action at a specific frame of video, or a sound at a specific 
frame of audio, to a particular frame’s action or sound in the video or audio of the Timeline.

The fastest way of using the Replace edit is to not bother setting either In or Out points in the 
Source Viewer, and to either use the duration of an existing clip intersecting the Timeline to 
define the edit, or a pair of timeline In/Out points specifying either a section of a clip you want 
to overwrite, or an empty section of the Timeline to which you want to edit.

Replace edits do not ripple the Timeline.

Fit to Fill (F12)
Fit to fill edits are the only edit type that actually use all four edit points, and it’s the only edit 
type that retimes clips at the same time as they’re being edited. By setting In and Out points in 
the incoming source clip, and another pair of In and Out points in the Timeline, you can stretch 
or compress the timing of the specified range of source media to cover the entire specified 
range of the Timeline. In the process, the speed ratio of the clip changes so the clip plays in 
either fast or slow motion.

Fit to fill edits are especially valuable when you have a source clip in which the action is slightly 
slow, and you just want to speed it up by squeezing it into a shorter duration of the Timeline. 
They’re also incredibly handy in situations when you have a gap in an edited sequence of clips 
to fill with a source clip that’s just not long enough, but in which slightly slower motion won’t be 
noticeable.

Fit to fill edits do not ripple the Timeline.

Ripple Del (Ripple Delete)
Pressing this key will delete the selected clip or clips, and then close any gaps that occur by 
rippling the Timeline to the left.
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Timecode Entry
This numerical keypad has many timecode-specific keys that allow you to input these values 
directly into DaVinci Resolve to navigate to specific points in the Timeline, or move forward and 
backward in the Timeline by specific increments.

The Numeric keypad 
and Timecode keys

How to Enter Timecode Values
When entering timecode, type each pair of hour, minute, second, and frame values from left to 
right, with a period representing a pair of zeros for fast entry. The numbers you enter appear in 
the timecode field at the upper right-hand corner of the Viewer with focus. When you’re finished 
typing, press the Return key to execute the Timecode command. The rules for timecode entry 
are as follows:

�� The right-most pair of timecode values (or period) you enter is always the frame number.

�� A period to the left or to the right of any number you type is considered to 
be a pair of zeroes. 

�� A single period between two numbers is considered to either be a single zero, or 
ignored if it’s between two pairs of numbers.

�� Any untyped pairs of values to the left of what you enter are assumed to be whatever 
those values were prior to the timecode you entered; this makes it easy to type partial 
timecode values even when the Timeline starts at hour one. 

�� It’s not necessary to enter colons or semicolons. 

Absolute Timecode Entry
Absolute timecode is entered simply by typing in a timecode value. So long as no clips or edit 
points are selected when you press the Return key, the playhead will move to that timecode 
value. If an edit point or clip is selected, those will be moved or trimmed to the corresponding 
timecode value, if possible.
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Here are some examples of absolute timecode entry using this method:

Original TC Value User-Typed Value New TC Value

01:10:10:10 15245218 15:24:52:18

01:10:10:10 2.. 01:02:00:00

01:10:10:10 15 01:10:10:15

01:10:10:10 12 01:10:10:12

01:10:10:10 1.2 01:10:01:02

01:10:10:10 1115.. 11:15:00:00

01:10:10:10 23... 23:00:00:00

Relative Timecode Entry
Relative timecode is entered by starting the timecode value with a plus (+) or minus (–). Adding 
a plus results in the value you type being added to the current timecode value for purposes of 
offsetting the playhead or moving a selection. Adding a minus will subtract the value you type 
from the current timecode value.

Here are two examples of  relative timecode entry:

User-Typed Value Result

+20. 00:00:20:00 is added to the current timecode value.

+3.. 00:03:00:00 is added to the current timecode value.

-5 00:00:00:05 is subtracted from the current timecode value.

F/TC (Frames/Timecode)
This button toggles between timecode (HH:MM:SS:FF) and frame count (23, 48, etc.) entry using 
the numerical keypad. For example, if you wanted to move forward 200 frames, you can press 
this key and then enter +200 and press the Enter key.

Dur Enter (Duration Enter)
Press this key to quickly change the duration of a transition or clip length to the exact number 
that you typed in.

00
This button adds two zeros to the timecode input rather than a single zero, to make numerical 
entry faster.
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QWERTY Keyboard Commands
The standard QWERTY shortcut keys have been modified slightly. 

Retime (R)
The Retime controls have been mapped to the letter R on the keyboard. This works both in the 
Cut and Edit pages.

Full View (P)
The full screen Viewer has been mapped to the letter P on the keyboard, and works in the Cut, 
Edit, Color and Fusion pages.

Hand (H)
This key allows you to select Hand or Pointer mode on the Viewer for repositioning of titles. 
This works on the Edit page only.

Zoom (Z)
This key will zoom to fit your media clip in the Viewer. This works in the Cut, Edit, and 
Color pages.

Autocolor (C)
This key will perform the Autocolor function on the clip that is underneath the playhead, or the 
selected timeline clip.

Fn
Pressing and holding this key while pressing a function key will return the normal function key 
mapping instead of the default DaVinci Resolve commands. Pressing and holding (Opt-Fn) while 
pressing a function key will return the OS function key mapping instead (for example, screen 
brightens, or audio level).  
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